
Oracle® Engineering
User's Guide
Release 12
Part No. B40003-02

November 2007



Oracle Engineering User's Guide, Release 12

Part No. B40003-02

Copyright © 2001, 2007, Oracle. All rights reserved. 

Primary Author:     Tyra Crockett, Amy Sonczalla, Debani Banerjee

The Programs (which include both the software and documentation) contain proprietary information; they 
are provided under a license agreement containing restrictions on use and disclosure and are also protected 
by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or
decompilation of the Programs, except to the extent required to obtain interoperability with other 
independently created software or as specified by law, is prohibited. 

The information contained in this document is subject to change without notice. If you find any problems in 
the documentation, please report them to us in writing. This document is not warranted to be error-free. 
Except as may be expressly permitted in your license agreement for these Programs, no part of these 
Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any 
purpose. 

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on 
behalf of the United States Government, the following notice is applicable: 

U.S. GOVERNMENT RIGHTS
Programs, software, databases, and related documentation and technical data delivered to U.S. Government 
customers are "commercial computer software" or "commercial technical data" pursuant to the applicable 
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, 
disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall 
be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent 
applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted 
Rights (June 1987). Oracle Corporation, 500 Oracle Parkway, Redwood City, CA 94065. 

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy and other measures to ensure the safe use of such applications if the Programs are used for such 
purposes, and we disclaim liability for any damages caused by such use of the Programs. 

The Programs may provide links to Web sites and access to content, products, and services from third parties. 
Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all
risks associated with the use of such content. If you choose to purchase any products or services from a third 
party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality
of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, 
including delivery of products or services and warranty obligations related to purchased products or services.
Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third 
party. 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks 
of their respective owners. 



    iii

 
Contents

Send Us Your Comments

Preface

1 Setting Up
Setup Overview......................................................................................................................... 1-1
Setup Flowchart and Checklist................................................................................................. 1-2
Setup Prerequisites ................................................................................................................... 1-3
Setup Steps ............................................................................................................................... 1-3
Defining ECO Types ................................................................................................................ 1-6
Defining ECO Autonumbering ................................................................................................1-8
Defining ECO Priorities ......................................................................................................... 1-10
Defining ECO Reasons ...........................................................................................................1-11
Defining ECO Approval Lists ................................................................................................ 1-12
Defining Material Dispositions ............................................................................................. 1-13
Starting the AutoImplement Manager....................................................................................1-14
Engineering Profile Options and Security Functions............................................................ 1-15
Profile Option Settings........................................................................................................... 1-16
Profile Options........................................................................................................................ 1-18

2 Engineering Change Orders
Overview of Engineering Change Orders................................................................................ 2-2
User Profile Options.................................................................................................................. 2-5
ECO Departments......................................................................................................................2-7
Transfer or Copy from within an ECO..................................................................................... 2-7
ECO Life Cycle.......................................................................................................................... 2-8



iv

ECO Approvals.......................................................................................................................... 2-9
Customizing the Standard Approval Process......................................................................... 2-11
The ECO Approval Item Type................................................................................................ 2-13
Summary of the ECO Approval Process................................................................................. 2-15
ECO Approval Process Activities............................................................................................2-16
Defining Engineering Change Orders.................................................................................... 2-20
Creating an ECO ..................................................................................................................... 2-22
Viewing ECO Approval Status .............................................................................................. 2-25
Rescheduling an ECO or Revised Items................................................................................. 2-27
Changing the ECO Status ....................................................................................................... 2-27
Defining Implementation Costs ............................................................................................ 2-28
Defining an ECO Revision ..................................................................................................... 2-29
Defining ECO Revised Items ................................................................................................. 2-29
Viewing ECO Schedule History ............................................................................................ 2-33
Viewing Item Revisions ......................................................................................................... 2-34
Viewing Routing Revisions.................................................................................................... 2-34
Defining Revised Operations ................................................................................................ 2-35
Defining Revised Resources .................................................................................................. 2-37
Defining Revised Components .............................................................................................. 2-39
Assigning or Deleting Substitute Components .....................................................................2-42
Assigning Reference Designators .......................................................................................... 2-43
Attaching Files to ECOs.......................................................................................................... 2-43
Transfer to Manufacturing from an ECO .............................................................................. 2-44
Copy to Manufacturing from an ECO ....................................................................................2-45
Mass Changing ECOs.............................................................................................................. 2-48
Implementing ECOs................................................................................................................ 2-48
Automatic Implementation..................................................................................................... 2-49
Cancelling ECOs and Revised Items ..................................................................................... 2-51
Viewing ECO Schedules ........................................................................................................ 2-52
Use Up ECOs........................................................................................................................... 2-53
MRP Planning for ECOs .........................................................................................................2-54
Unreleased Item Revisions in Oracle Work in Process.......................................................... 2-55
Implementation of ECOs on Jobs and Schedules.................................................................. 2-55
Purging ECOs.......................................................................................................................... 2-58
Engineering Change Orders Field Reference......................................................................... 2-59

3 Engineering Prototypes
Overview of Engineering Prototype Environment...................................................................3-1
ECOs on Engineering Items and Bills...................................................................................... 3-4
Transferring or Copying Engineering Items, Bills, and Routings........................................... 3-5



    v

4 Reports
Engineering Change Order Approval Lists Report ................................................................. 4-1
Engineering Change Order Detail Report ............................................................................... 4-1
Engineering Change Order Priorities Report .......................................................................... 4-3
Engineering Change Order Reasons Report ............................................................................ 4-3
Engineering Change Order Schedule Report .......................................................................... 4-3
Engineering Change Order Types Report ............................................................................... 4-6

A  Engineering Windows and Navigator Paths
Engineering Windows and Navigator Paths............................................................................ A-1
Oracle Engineering Character Mode Forms and Corresponding GUI Windows................... A-5

B Engineering Alerts
Engineering Alerts.................................................................................................................... B-1

C Engineering Tools Menu
Engineering Tools menu.......................................................................................................... C-1

D 21 CFR Part 11 Compliance
21 CFR Part 11 Overview.......................................................................................................... D-1
E-records and E-signatures for Oracle Engineering................................................................. D-2
Viewing Oracle E-Records and E-Signatures...........................................................................D-4

Index





    vii

 
Send Us Your Comments

Oracle Engineering User's Guide, Release 12
Part No. B40003-02

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. 
Your feedback is important, and helps us to best meet your needs as a user of our products. For example: 

• Are the implementation steps correct and complete? 
• Did you understand the context of the procedures? 
• Did you find any errors in the information? 
• Does the structure of the information help you with your tasks? 
• Do you need different information or graphics? If so, where, and in what format? 
• Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us your name, the 
name of the company who has licensed our products, the title and part number of the documentation and
the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to check that you have the latest version of the 
document and if any concerns are already addressed. To do this, access the new Applications Release 
Online Documentation CD available on Oracle MetaLink and www.oracle.com. It contains the most 
current Documentation Library plus all documents revised or released recently. 

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional). 

If you need assistance with Oracle software, then please contact your support representative or Oracle 
Support Services. 

If you require training or instruction in using Oracle software, then please contact your Oracle local office
and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at 
www.oracle.com. 





    ix

 
Preface

Intended Audience
Welcome to Release 12 of the Oracle Engineering User's Guide.

• Engineers 

• Oracle Engineering Applications users

See Related Information Sources on page x for more Oracle Applications product 
information. 

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, seven days a week. For TTY 
support, call 800.446.2398. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading technology 
vendors to address technical obstacles so that our documentation can be accessible to all
of our customers. For more information, visit the Oracle Accessibility Program Web site 
at http://www.oracle.com/accessibility/ . 



x

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise 
empty line; however, some screen readers may not always read a line of text that 
consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Structure
1  Setting Up
2  Engineering Change Orders
3  Engineering Prototypes
4  Reports
A  Engineering Windows and Navigator Paths
B  Engineering Alerts
C  Engineering Tools Menu
D  21 CFR Part 11 Compliance

Related Information Sources

Integration Repository
The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your 
instance is patched, the repository is automatically updated with content appropriate 
for the precise revisions of interfaces in your environment. 

Oracle Inventory User's Guide
This guide explains how to use Oracle Inventory

Oracle Bills of Material User's Guide
This guide explains how to use Oracle Bills of Material
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Oracle Work in Process User's Guide
This guide explains how to use Oracle Work in Process

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data unless 
otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your 
data and you lose the ability to audit changes to your data. 

Because Oracle Applications tables are interrelated, any change you make using an 
Oracle Applications form can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your tables 
get out of synchronization with each other, you risk retrieving erroneous information 
and you risk unpredictable results throughout Oracle Applications. 

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps track 
of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Setting Up

This chapter covers the following topics:

• Setup Overview

• Setup Flowchart and Checklist

• Setup Prerequisites 

• Setup Steps 

• Defining ECO Types 

• Defining ECO Autonumbering 

• Defining ECO Priorities 

• Defining ECO Reasons 

• Defining ECO Approval Lists 

• Defining Material Dispositions 

• Starting the AutoImplement Manager

• Engineering Profile Options and Security Functions

• Profile Option Settings

• Profile Options

Setup Overview
This section contains an overview of each task you need to complete to set up Oracle 
Engineering. 

Before you set up Oracle Engineering, you should: 

• Set up an Oracle Applications System Administrator responsibility. See: Oracle 
System Administration, Oracle Applications System Administrator's Guide.
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Setup Flowchart and Checklist
Some of the steps outlined in this flowchart and setup checklist are Required and some 
are Optional. Required Step With Defaults refers to setup functionality that comes with 
pre-seeded, default values in the database; however, you should review those defaults 
and decide whether to change them to suit your business needs. If you want or need to 
change them, you should perform that setup step. You need to perform Optional steps 
only if you plan to use the related feature or complete certain business functions.

The diagram below is described in detail in the Setup Checklist table, and Setup Steps 
section that follow.

The following table lists setup steps. After you log on to Oracle Applications, complete 
these steps to implement Oracle Engineering:

Step No. Required Step

Step 1 Required Set Profile Options

Step 2 Required Enter Employee

Step 3 Optional Define Change Order Types
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Step 4 Optional Define ECO Departments

Step 5 Optional Define Autonumbering

Step 6 Optional Define Approval Lists

Step 7 Optional Define Material Dispositions

Step 8 Optional Define Reasons

Step 9 Optional Define Priorities

Step 10 Optional Start AutoImplement 
Manager

Setup Prerequisites 
Before you set up Oracle Engineering, you must complete the setup for the following:

In Oracle Inventory:

• Define items. See: Defining Items, Oracle Inventory User's Guide

In Oracle Bills of Material:

• See: Setting Up, Oracle Bills of Material User's Guide

Setup Steps 

Setup Steps:
1. Set Profile Options (Required)

Profile options specify how Oracle Engineering controls access to and processes 
data. In general, profile options can be set at one or more of the following levels: 
site, application, responsibility, and user.

Oracle Engineering users use the Update Personal Profile Options form to set 
profile options only at the user level. System administrators use the Update System 
Profile Options form to set profile options at the site, application, responsibility, 
and user levels.

Context: Perform this step once for each entity, that is, site, application, 
responsibility, or user.
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2. Enter Employee (Required)

Define employees for your organization. ECO requestors and approvers must be 
defined as employees.

If you do not install Oracle Human Resource Management Systems with Oracle 
Engineering, you use the Enter Employee form to define and maintain employees in
Oracle Engineering.

If you install Oracle Human Resource Management Systems, you use the forms in 
Oracle Human Resource Management Systems instead to enter and maintain 
employees.

Context: Perform this step once for each entity organization. 

3. Define Change Order Types (Optional)

You can assign a change order type to your ECOs, either using the ECO change 
order type that Oracle Engineering provides or choosing a change order type from 
any number of types you define using your own terminology, such as Design 
Revision, Manufacturing Change Order, or Substitution Waiver. You can create 
change order types for ECOs with manufacturing items, or manufacturing and 
engineering items.

Default:  If you skip this step, Oracle shipped change order types will be used as 
the default value.

Context: Perform this step once per installation. 

4. Define ECO Departments (Optional

You can group users that use the engineering change order (ECO) system through 
ECO departments, creating multiple ECO departments within your Inventory 
organization. You can restrict access to ECOs by ECO department and require an 
ECO department on all ECOs-changing the responsible ECO department as the 
ECO moves through multiple departments.

Default:  If you skip this step, <enter value here> will be used as the default value.

Context: Perform this step once per organization.

5. Define Autonumbering (Optional)

You can define customized autonumbering (for a user, organization, or site) for 
new ECOs or mass change orders. You can use the autonumber default value when 
you define an engineering or mass change order, or you can override the 
autonumber default and assign your own number.

Context: Perform this step once per organizational user.

6. Define Approval Lists (Optional)

You can define lists of approvers required to approve an ECO before it can be 
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released. Oracle Engineering notifies the people on the list, using an alert, that the 
ECO requires their approval.

Context: Perform this step once per installation.

7. Define Material Dispositions (Optional)

You can define your own customized material dispositions, and then assign them to
revised items when defining ECOs.

8. Define Reasons (Optional)

You can define reasons for engineering change orders using your own terminology,
such as Model Year, Design, Safety, and Ergonomic. ECO reasons are for your 
reference use only.

Default:  If you skip this step, Oracle shipped reasons will be used as the default 
value.

Context: Perform this step once per organization.

9. Define Priorities (Optional)

You can define scheduling priorities for engineering changes to describe the 
urgency of your ECO. Priorities are for your reference use only.

Default:  If you skip this step Oracle shipped priorities will be used as the default 
value.

Context: Perform this step once per organization.

10. Start AutoImplement Manager (Optional)

If you automatically implement ECOs, you must specify the frequency that you 
want the AutoImplement manager to run. Once an ECO has been released to the 
autoimplement manager, you can automatically implement all scheduled ECO 
revised items whose effective date is less than or equal to the current date.

Related Topics
Starting the AutoImplement Manager, page 1-14

Defining ECO Priorities, page 1-10

Defining ECO Reasons, page 1-11

Defining Material Dispositions, page 1-13

Defining ECO Approval Lists, page 1-12

Defining ECO Autonumbering, page 1-8

Defining ECO Types, page 1-6

Oracle Engineering Profile Options and Security Functions, page 1-15
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Defining ECO Types 
Engineering change order (ECO) types help classify engineering and mass change 
orders to items and bills of material, and determine whether such orders apply to 
engineering in addition to manufacturing.

An ECO type can be associated with an Oracle Workflow process. If so, a priority can 
optionally be associated with the ECO type.

If you define an ECO using a type and priority combination (even if the priority is 
blank) that is associated with a workflow process, Workflow will control the ECO 
approval process. If the type and priority combination is not associated with a workflow
process, the ECO approval status defaults to Approved.

Use this form to define and update change order types that determine the types of items
and bills of material you can modify on mass change orders.

Note: You can now create an engineering change order type in the 
Change Types window with a name of up to 80 characters in length in 
the Type field. Previously, the name of an engineering change order 
type was limited to 10 characters.

You can now set up engineering change order types in the Change 
Types window in multiple languages. 

To define an ECO type:
1. Navigate to the Change Types window.
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2. Enter alphanumeric text for a unique change order type.

3. Indicate whether the change order type can revise both engineering and 
manufacturing items and bills.

ECOs with an engineering change type can include both engineering and 
manufacturing items. ECOs with a manufacturing change type cannot include 
engineering items.

If an ECO with a status of Open, Hold, Release, or Schedule is using this ECO type, 
this value cannot be updated.

You must choose the Manufacturing option in this field for Oracle Engineering.

4. Optionally, enter a description for the change order type.

5. Enter a date to inactivate the change order type. As of this date, you can no longer 
assign this change order type to a change order.

6. To associate this ECO type with a Workflow process, choose the Processes button.

If you do not associate this ECO type with a Workflow process, any ECO using this 
type will default to Approved.

To associate an ECO type with a Workflow process:
1. Navigate to the Change Type Processes window. Do this by choosing the Processes 

button from the Change Types window.

2. 
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Optionally, select an ECO priority.

Note: ECO types are not organization-specific. However, ECO 
priorities are organization-specific. This ECO type-priority 
combination will only be available in the current organization.

3. Select a workflow process to associate with this ECO type.

Whenever this type and priority combination (even if priority is blank) is used for 
an ECO, Workflow will control the ECO approval process.

Related Topics
Overview of Engineering Change Orders, page 2-2

Engineering Change Order Types Report, page 4-6

Workflow for ECO Approvals, page 2-9

Defining ECO Priorities, page 1-10

Defining ECO Autonumbering 
You can define and update customized autonumbering to use as defaults when creating
new engineering change orders (ECOs) and mass change orders.

Define autonumbering for a particular user in an organization, a user across all 
organizations, all users in one organization, or all users across all organizations.

When you first define an ECO, Engineering uses the following hierarchy to determine 
the prefix to use for autonumbering:

• Specific prefix for you and your current organization

• Specific prefix for you across all organizations

• Specific prefix for all users for your current organization

• Specific prefix for all users across all organizations

For example, if a prefix is set up for you and the current organization, it supersedes a 
prefix defined for you across all organizations.

When defining an ECO, you can either accept a default ECO number or manually enter 
one. Engineering displays the prefix along with the next available number. If 
Engineering does not find an autonumbering prefix, you must assign an ECO number 
manually.



Setting Up    1-9

Important:  When creating an ECO, once a default ECO autonumber 
displays, Engineering considers that number used, even if you do not 
save your changes and create the ECO using that number. For example,
if you begin to define an ECO called ABC234, and then decide to 
abandon your changes, Engineering presents the next ECO number as 
ABC235. You can manually change this number.

To define ECO autonumbering:
1. Navigate to the ECO Autonumbering window.

2. Enter or select a specific UserName to define autonumbering for a particular user, 
or select the All Other Users record to define autonumbering for all other users.

If you have privilege only to define autonumbering for yourself, the default is your 
username.

3. Enter a specific organization to define autonumbering for a particular organization, 
or select the All Other Organizations record to define autonumbering for all other 
organizations.
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Important: The information you provide in the Organizations 
region is associated with the specific user or the All Other Users 
record in the Users region.

4. Enter a prefix to use as the first characters for each defaulted ECO identifier for the 
specific user or All Other Users, whichever is currently selected.

You can define only one prefix per user per organization. You can define only one 
prefix per user across all other organizations.

5. Enter a Next Number to use as the of the base of the numeric portion of ECO 
autonumbering.

The combined prefix and next number-the autonumber-is incremented when each 
ECO is created. For example, if you enter 100 and your prefix is ABC, the first ECO 
number is ABC100. The next will then be ABC101.

Each new ECO number is defaulted to one integer plus the last used ECO number. 
When defining a new ECO, you can override this with a higher value. The next 
ECO number will then be one integer greater. For example, assuming ABC as the 
prefix and no ECOs defined using ABC, ABC1 is the default. If you have defined an
ECO called ABC234, ABC235 is the default.

You cannot enter a prefix and next number that, when used together, exceeds ten 
alphanumeric characters.

Related Topics
Engineering Change Orders, page 2-2

Creating an ECO, page 2-22

Defining ECO Priorities 
Engineering change priorities enables you to specify the urgency of the engineering 
change order. You can define a priority, enter a description, and enter a priority level 
between zero and nine.

Note: ECO priorities can be specified when associating ECO types with 
Oracle Workflow processes, which are used for ECO approvals.

To define an ECO priority:
1. Navigate to the ECO Priorities window.
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2. Enter alphanumeric text to describe a unique priority for an ECO. For example, you 
could enter 1 to indicate an important priority.

3. Enter a priority sequence. This is a number between 0 and 9. For example, you can 
use 0 to denote the highest priority and 9 the lowest.

4. Enter a description for the priority.

5. Optionally, enter a date on which the priority becomes inactive. As of this date, you
can no longer assign the priority to an ECO.

Related Topics
Defining ECO Types, page 1-6

Engineering Change Order Priorities Report, page 4-3

Defining ECO Reasons 
Use engineering change reasons to categorize and identify causes for ECOs. 
Engineering uses ECO reasons for reference only.

To define an ECO reason:
1. Navigate to the ECO Reasons window.
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2. Enter alphanumeric text to describe a unique reason for initiating an engineering 
change. For example, you could define a reason obsolete to indicate an obsolete part, 
or waiver to indicate a component change on a bill of material.

3. Enter a description of the ECO reason.

4. Enter a date on which the reason becomes inactive. As of this date, you can no 
longer assign the reason to an ECO.

Related Topics
Engineering Change Order Reasons, page 4-3

Defining ECO Approval Lists 
Engineering lets you define lists of approvers for ECOs. Each approval list can be used 
as a role by Oracle Workflow.

One workflow process, named Standard Approval Process, is installed with 
Engineering.

To define an ECO approval list:
1. Navigate to the Approval Lists window.
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2. Enter the approval list name, a description, and, optionally, a date on which you 
can no longer assign the approval list to an ECO.

3. Enter a sequence for the approver. This number indicates the sequence of the 
approver for the ECO. Engineering uses this for information purposes only.

4. Enter an employee name for the approver.

5. Enter a date for this approver on the approval list. As of this date, the approver is 
no longer notified when an ECO requires their approval.

Related Topics
ECO Approval Statuses, page 2-59

Workflow for ECO Approvals, page 2-9

Viewing ECO Approval Status, page 2-25

Engineering Change Order Approval Lists Report, page 4-1

Defining Material Dispositions 
Engineering enables you to define customized material dispositions. You can then 
assign them to revised items when defining an ECO.
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To define a material disposition:
1. Navigate to the Material Dispositions Lookups form and define your material 

disposition.

2. Enter a new code and description for your material disposition.

3. Save your work.

4. Navigate to the Revised Items window and assign your material disposition to 
revised items.

Related Topics
Defining ECO Revised Items, page 2-29

Starting the AutoImplement Manager
The AutoImplement Manager runs at the specified dates and times and automatically 
implements items whose schedule dates occur on or before the current date. 
Engineering change orders or revised items whose status is Scheduled are automatically
implemented.

To start the AutoImplement Manager:
1. Navigate to the Start AutoImplement Manager window.
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2. Enter or select the Automatic Engineering Change Order Implementation program.

3. Enter the dates and times when to run the ECO auto implement process.

Related Topics
Changing the ECO Status, page 2-27

Engineering Profile Options and Security Functions
During implementation, the system administrator sets up and maintains security 
functions and profile options.

A security function determines whether an Engineering Change Order (ECO) approval 
Workflow process can be submitted or aborted.

Engineering Change Orders: Cancel (ENG_ENGFDECN_CANCEL)
Determines whether ECOs can be cancelled.

Engineering Change Orders: Implement (ENG_ENGFDECN_IMPLEMENT)
Determines whether ECOs can be implemented.

Engineering Change Orders: Release (ENG_ENGFDECN_RELEASE)
Determines whether ECOs can be released.

Engineering Change Orders: Reschedule (ENG_ENGFDECN_RESCHEDULE)
Determines whether ECOs can be rescheduled.

Engineering Change Orders: Schedule (ENG_ENGFDECN_SCHEDULE)
Determines whether ECOs can be scheduled.

Engineering Change Orders: Update (ENG_ENGFDECN_UPDATE)
Determines whether ECOs can be updated.

Engineering Items: Delete (ENG_INVIDITM_DELETE)
Determines whether engineering items can be deleted from the Bills of Material or 
Routings windows.
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Engineering Items: Revisions (ENG_INVIDITM_REVISIONS)
Determines whether revisions for engineering items can be updated.

Engineering Items: Transfer (ENG_INVIDITM_TRANSFER)
Determines whether engineering items can be transferred to manufacturing.

Profile Option Settings
You can set or view the following profile options in Oracle Order Entry/Shipping. The 
following table includes some profile options from other applications that are used by 
Engineering.

Profile Option Settings

Profile 
Option

User User Resp App Site Required
?

Default 
Value

ENG: 
Change 
Order 
Autonum
bering - 
System 
Administ
rator 
Access

- Y Y Y Y Required No

ENG: 
ECO 
Departm
ent

- Y Y Y Y Optional No

ENG: 
ECO 
Revision 
Warning

- 0 0 0 Y Optional No

ENG: 
Engineeri
ng Item 
Change 
Order 
Access

- Y Y Y Y Optional Yes
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Profile 
Option

User User Resp App Site Required
?

Default 
Value

ENG: 
Mandator
y ECO 
Departm
ents

- 0 0 0 Y Optional No

ENG: 
Model 
Item 
Change 
Order 
Access

- Y Y Y Y Optional Yes

ENG: 
Planning 
Item 
Change 
Order 
Access

- Y Y Y Y Optional No

ENG: 
Require 
Revised 
Item 
New 
Revision

- 0 0 Y Y Optional No

ENG: 
Standard 
Item 
Change 
Order 
Access

- Y Y Y Y Optional Yes

ENG: 
Allow 
Eng 
Comps 
for MFG 
Items in 
ECO

- - 0 Y Y Optional Yes
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Profile 
Option

User User Resp App Site Required
?

Default 
Value

ENG: 
MRP 
Active 
Flag 
default 
for ECO

- - 0 Y Y Optional Yes

ENG: 
Update 
Unrelease
d WIP 
Jobs

Y Y Y Y Y Optional Yes

ENG: 
Internal 
User 
Default 
Role for 
Changes

- - 0 0 Checked Optional Yes

Y You can update the profile option. 

- You can view the profile option value but you 
cannot change it. 

0 You cannot view or change the profile option 
value. 

Profile Options
You can set or view profile options in Oracle Engineering. The profile options 
mentioned in the preceding table are described here.

ENG: Allow ENG COMPS for MFG Items in ECO
When this profile option is set to Yes, you can add engineering components to a 
manufacturing bill of material, but you must transfer the engineering component to 
manufacturing before implementing the engineering change order. When this profile 
option is set to No, you cannot add engineering components to a manufacturing bill of 
material.
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ENG: Change order Autonumbering-System Administrator Access
Indicates whether you can define ECO autonumbering for all users or for yourself only. 

ENG: ECO Department
Indicates the default department Engineering uses when you define an ECO. An ECO 
department is the department currently responsible for an ECO. It restricts departments
from updating ECOs for which they are not responsible. 

ENG: ECO Revision Warning
Indicates whether to raise a warning but still implement ECO revisions with pending 
lower level revisions (Yes), or to raise an error and not perform the implementation (No
or blank). A blank (or "null") value is equivalent to No. 

ENG: Engineering Item Change Order Access
Indicates whether a Change Order Type allowing the "Engineering Also" is available for
selection. Set to No the Change Order Types which do not have the "Engineering Also" 
attribute selected.

ENG: Internal User Default Role for Changes
This is one of the roles than can be configured. The roles are used to define a set of 
privileges for the user. The roles are mentioned below:

Approver: User can approve the change order, may have edit privileges

Owner: User that submits the change order and has edit or read privileges

Reviewer: User can read the change order and material associated with the change 
order and has no edit privileges.

ENG: Mandatory ECO Departments
Indicates whether it is mandatory to assign a department to each ECO so you can 
enforce a security policy. 

ENG: Model Item Change Order Access
Indicates whether you can revise model and option class items on ECOs. 

ENG: MRP Active flag default for ECO
Indicates the default active flag for ECO revised items.

ENG: Planning Item Change Order Access
Indicates whether you can revise planning items on ECOs. 
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ENG: Require Revised Item New Revision
Indicates whether it is mandatory to assign a new revision to revised items on ECOs. A 
blank (or "null") value is equivalent to No. 

ENG: Standard Item Change Order Access
Indicates whether you can revise standard items on ECOs. 

ENG: Update Unreleased WIP Jobs
Indicates if you can update unreleased WIP jobs.

Related Topics
Overview of Function Security, Oracle Applications System Administrator's Guide

Implementing Function Security, Oracle Applications System Administrator's Guide

Setting Your Personal User Profile, Oracle Applications User's Guide

Common User Profile Options, Oracle Applications User's Guide

Profile Options in Oracle Application Object Library, Oracle Applications User's Guide
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2
Engineering Change Orders

This chapter covers the following topics:

• Overview of Engineering Change Orders

• User Profile Options

• ECO Departments

• Transfer or Copy from within an ECO

• ECO Life Cycle

• ECO Approvals

• Customizing the Standard Approval Process

• The ECO Approval Item Type

• Summary of the ECO Approval Process

• ECO Approval Process Activities

• Defining Engineering Change Orders

• Creating an ECO 

• Viewing ECO Approval Status 

• Rescheduling an ECO or Revised Items

• Changing the ECO Status 

• Defining Implementation Costs 

• Defining an ECO Revision 

• Defining ECO Revised Items 

• Viewing ECO Schedule History 

• Viewing Item Revisions 

• Viewing Routing Revisions

• Defining Revised Operations 
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• Defining Revised Resources 

• Defining Revised Components 

• Assigning or Deleting Substitute Components 

• Assigning Reference Designators 

• Attaching Files to ECOs

• Transfer to Manufacturing from an ECO 

• Copy to Manufacturing from an ECO 

• Mass Changing ECOs

• Implementing ECOs

• Automatic Implementation

• Cancelling ECOs and Revised Items 

• Viewing ECO Schedules 

• Use Up ECOs

• MRP Planning for ECOs 

• Unreleased Item Revisions in Oracle Work in Process

• Implementation of ECOs on Jobs and Schedules

• Purging ECOs

• Engineering Change Orders Field Reference

Overview of Engineering Change Orders
Engineering Change Orders (ECOs) enable you to control new item revisions and bill of
material changes. With one ECO you can group several bill of material changes that 
affect one or more bills.

You can define ECOs for all types of items and bills, including:

• Manufacturing and engineering items

• Bills and their components

• Planning, model, option class, and standard items

• Primary and alternate bills of material

An ECO specifies changes to one or more items that are logically related to each other, 
such as a new product introduction. Each ECO specifies changes for one or more 
revised items and each revised item can have one or more revised components.

Depending on the ECO type, an ECO can update only the manufacturing bills or both 



Engineering Change Orders    2-3

manufacturing and engineering bills. 

You can add either engineering or manufacturing items as components on engineering 
bills. However, you can only add manufacturing items as components on 
manufacturing bills.

You can transfer or copy engineering items, bills, and routing to manufacturing as part 
of an ECO. 

Revised Items
Revised items can be either items or bills. If a revised item is a bill, you can change the 
item revision and component information (revised components). If a revised item 
defines a new bill, you can create revised components by copying an existing bill.

Engineering changes can be defined by date and or model/unit number effectivity. You 
should assign an effective date and model / unit number for each revised item on an 
ECO. Engineering uses this information to implement the ECO and to identify past due 
ECOs. Each time you change a revised item's effective date, Engineering adds an entry 
to list effective date changes. You can also specify an early effective date that 
determines the earliest date that you can manually implement a change. If you do not 
enter an early effective date, you can manually implement the change at any time. You 
can reschedule an ECO by entering a new effective date. A date effective revised item 
can only have date effective revised components.

A unit effective revised item can have both unit and/or date effective components. All 
unit effective revised items must have a from end item unit number specified, if the 
effectivity profile is set to Unit effectivity. The from end item unit number will be null 
and non-updatable for date effective revised items. The to end item unit number field 
will also be null and non-updatable for revised components of date effective revised 
items If you are implementing a ECO for a unit effective component, the from unit 
number needs to be specified in the revised item block and the to unit number needs to 
be specified in the revised components block.

Note: There are two conditions under which revised items are not 
implemented: if the early effective date is greater than the current date, 
and if the user does not have access to the item type of the revised item.
For example, if the revised item is a model item and the user does not 
have access to model items, the revised item is not implemented. The 
same is true for option class, planning, and standard items.

You can control whether Oracle Master Scheduling/MRP plans your proposed changes 
before implementation. If you have engineering changes that are firm, but whose 
effective date is in the future, you may want planning to consider those changes. You 
can choose to plan changes on any pending ECO regardless of the ECO status. Changes 
to the ECO status or the revised item status will automatically update the MRP active 
attribute. However, you can always manually set the MRP active attribute as desired.

For each revised item, you can also specify whether Engineering should update work in
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process material requirements. When you implement such an ECO revised item, 
Engineering automatically re-explodes and updates the bill of material for all 
unreleased jobs and repetitive schedules for that item.

Engineering also updates repetitive schedules with statuses of Released, Complete, or 
On hold accordingly.

Revised Components
You can add, change, or delete bill of material components and their attributes. The 
components and their attributes have the same restrictions as when you define a bill 
using Oracle Bills of Material. For example, you can only add components that are 
standard, model, or option class items for revised items that are model items.

Revised Operations
You can define an ECO for Operations. You can add, disable, and change Department 
information, Effective dates, Minimum Transfer quantities, and many other attributes.

Revised Resources
You can define an ECO for Resources. You can add, change, and disable resource 
information.

Revisions
When you enter a revised item on an ECO, Engineering displays the current and latest 
revision of the item. The latest revision could be higher than the current revision if the 
latest revision is on a pending ECO.

Engineering uses the ENG: Require Revised Item New Revision to control new item 
revisions for each engineering change. If engineering changes always correspond to 
new item revisions, set this profile option to Yes. Doing so will force a new item 
revision for all revised items on an ECO. When you require new item revisions, you can
track all engineering changes to an item by revision. For example, you can group 
related design changes on an ECO and roll revisions for each item to reflect the latest 
design.

If you define related ECOs at different times, set this profile option to No so you 
increment the revision only once. You can then define one ECO to change the revised 
item revision and other ECOs that do not change the item revision. Minor changes that 
do not affect form, fit, or function of an item may not require new revisions.

Transfer and Copy to Manufacturing
You can transfer or copy entities to manufacturing. Transfer and copy transactions must
proceed through the required approval cycles before they are implemented. The system
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captures all transfer and copy transactions for future reference.

ECO Access Control
Oracle Engineering controls the access to ECOs and the changes you can specify on 
them using profile options, security functions, item types, ECO types, and ECO 
departments.

ECO Types
For each ECO type, you specify if it can update engineering items. Only users whose 
profile option indicates they can update engineering items can choose ECO types that 
update engineering items.

Related Topics
Implementation of ECOs on Jobs and Schedules, page 2-55

ECO Revised Item Statuses, page 2-59

Copy Engineering Items to Manufacturing, page 2-45

Transfer Engineering Items to Manufacturing page , page 2-44

Bill / Component Validation Rules, Oracle Bills of Material User's Guide

User Profile Options
User profile options control the types of items you can revise on an ECO. You can 
specify whether a user or responsibility can revise model and option class items, 
planning items, standard items, or engineering items on ECOs.

Engineering uses the following four profile options to control the types of items you can
change on an ECO: 

• ENG: Engineering Item Change Order Access (engineering items)

• ENG: Model Item Change Order Access (model and option class items)

• ENG: Planning Item Change Order Access (planning items)

• ENG: Standard Item Change Order Access (standard items)

Engineering enforces security for engineering items by letting only the users who are 
allowed to update engineering items choose ECO types that update engineering items. 
In addition, to update engineering bills of material for manufacturing items, you must 
choose ECO types that update engineering items.

Each time you try to add a revised item to an ECO, Engineering checks to see if you can 
update that item based on its BOM Item Type and your profile options.
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For example, you might define several ECO types that can update manufacturing items,
and only define one type that can update engineering items.

You might also specify profile options to control access to BOM item types by user, as 
shown in the following table:

User Profile Options

User ECO 
Department

Standard 
Item Access

Planning 
Item Access

Model / 
Option Class
Item Access

Engineering 
Item Access

Joe Product 
Engineering

Yes No No Yes

Mary Mfg. 
Engineering

Yes No Yes No

Fred Customer 
Service

No No Yes No

Sue Material 
Planning

No Yes No No

Dave Production Yes No Yes No

In the example, Joe can create ECOs that update standard items. Mary can create ECOs 
that update manufacturing standard items and model / option class items. But Mary is 
not allowed to update engineering items.

Profile Settings for Changing Bills Only With ECOs
To limit user's access to bills of material only through ECOs, set the following Bills of 
Material profile options to No:

• BOM: Standard Item Access

• BOM: Planning Item Access

• BOM: Model Item Access

And the following Engineering profile options to Yes:

• ENG: Standard Item Change Order Access

• ENG: Planning Item Change Order Access
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• ENG: Model Item Change Order Access

• ENG: Engineering Item Change Order Access.

Profile Settings for Changing Bills With or Without ECOs
With the same seven profile options listed above all set to Yes, bills can be changed with
or without ECOs.

ECO Departments
You can assign users to departments and secure each ECO to a department so that only 
those users can access the ECO. If you do not specify a department for an ECO, any user
can access it. If you do not assign a user to a department, they can access all ECOs. 
Setting the ENG: Mandatory ECO Departments to Yes requires you to specify a 
responsible department on every ECO.

You can update the responsible department as you release an ECO from the current 
ECO department. For example, if Product Engineering releases an ECO to 
Manufacturing Engineering, they can reassign the responsible department so it becomes
visible and updatable to users assigned to the Manufacturing Engineering ECO 
department.

Related Topics
Engineering Profile Options and Security Functions, page 1-15

Oracle Bills of Material Profile Options, Oracle Bills of Material User's Guide

Defining ECO Types, page 1-6

Access Control by Item Type, Oracle Bills of Material User's Guide

Transfer or Copy from within an ECO
You can transfer or copy engineering items, bills and routing to manufacturing from an 
ECO. When you transfer or copy an item, a bill or a routing to manufacturing, it passes 
through the necessary approval cycles and is implemented like other revised item 
changes. You can perform transfer or copy on only approved ECOs. 

You can schedule transfer or copy transactions the same way you schedule revised 
items on an ECO. When the schedule date arrives, the items, bills and routings are 
automatically transferred or copied to manufacturing.

When transfer or copy of items is done through an ECO, the system captures the 
transaction history for future reference. It also give you the flexibility of creating all 
transactions when identified, and you may implement them at a later date.
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Related Topics
Transfer Items to Manufacturing from an ECO, page 2-44.

Copy Items to Manufacturing from an ECO: page, page 2-45.

Transferring or Copying Engineering Items, Bills, and Routings, page 3-5.

Copying Bill and Routing Information, Oracle Bills of Material User's Guide.

ECO Life Cycle
Engineering uses two ECO status fields to control the ECO life cycle: ECO Status and 
ECO Approval Status. See: ECO Statuses, page 2-59.

You can change the status of an ECO. You can open, hold, release, schedule, implement,
or cancel a revised item or an ECO. Engineering does not let you set the ECO Status 
field to Implemented or Scheduled if the approval status has not been set to Approved. 

The following table illustrates a typical ECO life cycle:

ECO Status Flow

Sequence Action Approval Status ECO Department

Start creating new 
ECO

Hold Not Submitted for 
Approval

Mfg. Engineering

Complete data entry Open Not Submitted for 
Approval

Mfg. Engineering

Submit approval 
process

n/a Approval Requested Mfg. Engineering

Oracle Workflow 
controls approval 
process

n/a Approval Requested Mfg. Engineering

Approve and release Released Approved Production

Production updates 
date

Scheduled n/a Production

Effective date arrives Implemented n/a Production
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Related Topics
Creating an ECO, page 2-22

Viewing ECO Approval Status, page 2-25

Implementing ECOs, page 2-48

ECO Approvals
ECOs can be approved in three ways, two of which require an approval process. The 
third requires no approval process. 

First, the ECO, based on the ECO type in combination with the ECO priority, can be 
associated with an Oracle Workflow process. Once approval is granted, Workflow 
automatically updates the approval status.

Second, a simple approval list can be used, which sends an Oracle Alert to all those 
listed requesting their approval. Once approved, you must manually update the 
approval status. This approval option does not require an Oracle Workflow process.

The third method is to use neither of the above; the ECO needs no formal approval 
process and is given the status of Approved.

If the ECO is associated with an Oracle Workflow process, only Workflow may set the 
status to Approved. If the ECO has an approval list, you must set the status to 
Approved manually after the ECO has been approved by the appropriate member(s) on
the approval list. 

If neither is used, the ECO is set to Approved but can be manually rejected.

The following table describes the conditions under which the different approval 
statuses can be used:

Approval Status Conditions

Condition Valid Approval Statuses

No approval list / no workflow approval 
process

Approved (default), Rejected

Approval list Not Submitted for Approval (default), Ready 
to Approve (Oracle Alert fires), Approval 
Requested, Rejected, Approved

Workflow approval process Not Submitted for Approval, Approval 
Requested, Rejected, Approved, Processing 
Error
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Workflow for ECO Approvals
Most organizations have some form of approval process before engineering change 
orders (ECOs) are implemented. By using Oracle Workflow, the approval process can 
be customized to meet each organization's needs.

Business rules for the approval of ECOs are defined in a workflow process. For each 
ECO, Workflow manages adherence to these business rules, including:

• submission of the completed ECO for approval via Workflow

• enforced approval process for an ECO type

• communication of messages via Notification Viewer, electronic mail, or web 
browser

• review of ECO from Notification Viewer

• automatic processing of user responses and update of system

• workflow status indicator for ECOs

• usage of current approval lists (roles) in the workflow process.

Once the ECO is created, Workflow takes over processing. 

When Workflow is in control of the approval process, the ECO approval status is set to 
Approval Requested. Before the approval status is changed, the workflow approval 
process can be aborted.

Workflow manages the approval process until the entire approval flow is complete. 
Only then is the ECO approval status updated to either Approved or Rejected. If an 
error occurs during the Workflow approval process, the approval status is set to 
Processing Error. 

ECO Approval List Setup
Workflow can use roles whenever an activity involves several users. Approval lists 
defined in Engineering can be used to create roles. Roles are made up of either one 
approval list or one employee previously defined with the Enter Person window.

The ECO workflow approval process will notify all persons in the role, regardless if the 
role is defined using an approval list or an individual employee.

To approve (or reject) the ECO, approvers must respond to the notification. If the 
approver has an Oracle Applications Object Library account, they can respond to ECO 
approval requests using either a web browser or the Notification Viewer. If not, the 
approver can respond via electronic mail, provided their address is defined in the Enter 
Person window.



Engineering Change Orders    2-11

ECO Types and Priorities Setup
ECO types can be associated with a workflow process. If you do not associate an ECO 
type with a workflow process, there can be no workflow approval process for ECOs 
using that ECO type. If there is an approval list, the ECO cannot be associated with a 
process.

ECO types that are associated with a workflow process can optionally be associated 
with an ECO priority. If so, ECOs that use the type/priority combination are approved 
via Workflow. Doing so enables workflow approval processes to be ranked according to
priority.

ECO Approval
The only user intervention required for a workflow approval process is for individual 
approvers to respond to an ECO approval notification. Once the process is complete, 
Workflow automatically updates the ECO approval status.

Related Topics
Workflow for ECO Approvals, page 2-9

ECO Approval Statuses, page 2-59

Customizing the Standard Approval Process
Once you install Oracle Engineering, you can view the Standard Approval Process in a 
Process window using Oracle Workflow Builder.
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To Display the Standard Approval Process in Oracle Workflow Builder:
1. Choose Open from the File menu, and connect to the database where you installed 

Oracle Engineering.

2. Select the ECO Approval item type.

3. Expand the data source, then the ECO Approval item type branch within that data 
source.

4. Expand the Processes branch within ECO Approval then double-click on the 
Standard Approval Process activity to display the diagram of the process in a 
Process window.

Required Modifications:
You must make the following modifications to the Standard Approval Process before 
you can use it to initiate a workflow:

1. Specify an Approval for the ECO Approval Process

• Choose Load Roles From the Database from the File menu. Select the role you 
wish to use for an approval. 
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Note: A role can represent a person or a group of persons. You 
must have already defined approvers and/or approval lists in 
Oracle Engineering.

• Select the Standard Approval Notification activity to view its properties.

• Enter Constant as the Performer Type. Select a Performer from the adjacent list 
of values.

• Select OK to save your changes.

Optional Modifications:
Although you can use the Standard Approval Process as is, you may want to customize 
the process further to accommodate your organization's specific needs.

Creating a New Custom Process:
You can use the Standard Approval Process for your ECO approvals or create you own 
approval process using Oracle Workflow. You must install Oracle Workflow to create 
your own approval process.

Related Topics
ECO Approval Process Activities, page 2-16

Defining ECO Types, page 1-6

Defining ECO Approval Lists, page 1-12

Creating an ECO, page 2-22

Viewing ECO Approval Status, page 2-25

The ECO Approval Item Type
The ECO Approval process is associated with an item type called ECO Approval. This 
item type represents the domain of all processes and activities used in the ECO 
Approval process and used by Oracle Engineering.

The following table presents ECO approval item type attributes:
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ECO Approval Item Type Attributes

Display Name Description Type Length

Approval Status ECO Approval Status Text 80

Attribute1 Attribute1 Text 150

Attribute2 Attribute2 Text 150

Attribute3 Attribute3 Text 150

Attribute4 Attribute4 Text 150

Attribute5 Attribute5 Text 150

Attribute6 Attribute6 Text 150

Attribute7 Attribute7 Text 150

Attribute8 Attribute8 Text 150

Attribute9 Attribute9 Text 150

Attribute10 Attribute10 Text 150

Attribute11 Attribute11 Text 150

Attribute12 Attribute12 Text 150

Attribute13 Attribute13 Text 150

Attribute14 Attribute14 Text 150

Attribute15 Attribute15 Text 150

Attribute Category Attribute Category Text 30

ECO Engineering Change 
Order

Text 30

Change Type Change Type Text 10
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Display Name Description Type Length

ECO Dept Code ECO Department 
Code

Text 3

ECO Dept Name ECO Department 
Name

Text 60

ECO Description ECO Description Text 2000

ECO Status ECO Status Text 80

Estimated Eng Cost Estimated 
Engineering Cost

Number n/a

Estimated Mfg Cost Estimated 
Manufacturing Cost

Number n/a

Full Name Change Requestor Text 240

Initiation Date ECO Initiation Date Date n/a

Organization Code Organization Code Text 3

Organization Name Organization Name Text 60

Org ID Organization ID Number n/a

Priority Code ECO Priority Code Text 10

Reason Code ECO Reason Code Text 10

Rev ID Revision ID Number n/a

Summary of the ECO Approval Process
The ECO Approval process consists of nine unique activities as displayed in the process
diagram. The ECO Approval workflow begins when you submit an approval 
requisition from the ECO form in Oracle Engineering. The workflow begins at node 1 
with the start activity. At node 2, the function gets all required ECO attributes and sets 
the item attributes. The ECO Approval status is changed to Approval Requested at 
node 3 and users on the approval list are notified of the ECO. If the user approves the 
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ECO, the MRP Active ECO attribute is set to YES at node 4 and the approval status is 
set to Approved at node 5. If the user rejects the ECO, the MRP active attributes is set to 
NO at node 7 and the ECO approval status is set to Rejected at node 8. The workflow 
process ends either at node 6 or at node 9 depending on whether the user approves the 
ECO.

The following diagram illustrates what is described in the text above.

ECO Approval Process Activities
This section provides a description of each activity in the process, listed by the activity's
display name. Following is the legend for the information displayed, and immediately 
followed is the list of activities.

Start (Node 1):
This is a standard function activity that simply marks the start of the process.

• Function - WF_STANDARD.NOOP

• Result Type - None

• Required - Yes

• Prerequisite Activities - None

• Item Attributes Set by Function - None

• Item Attributes Retrieved by Function - None
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Get ECO Attributes (Node 2) :
This function gets all required ECO attributes and sets the item attributes.

• Function - ENG_WORKFLOW_API_PKG.GET_ECO_ATTRIBUTES

• Result Type - None

• Required - Yes

• Prerequisite Activities - None

• Item Attributes Set by Function - CHANGE_NOTICE

• ECO_DESCRIPTION

• ECO_STATUS

• INITIATION_DATE

• PRIORITY_CODE

• REASON_CODE

• ESTIMATED_ENG_COST

• ESTIMATED_MFG_COST

• ATTRIBUTE_CATEGORY

• ATTRIBUTE1

• ATTRIBUTE2

• ATTRIBUTE3

• ATTRIBUTE4

• ATTRIBUTE5

• ATTRIBUTE6

• ATTRIBUTE7

• ATTRIBUTE8

• ATTRIBUTE9

• ATTRIBUTE10
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• ATTRIBUTE11

• ATTRIBUTE12

• ATTRIBUTE13

• ATTRIBUTE14

• ATTRIBUTE15

• APPROVAL_STATUS

• ORGANIZATION_CODE

• ORGANIZATION_NAME

• FULL_NAME

• CHANGE_TYPE

• ECO_DEPT_NAME

• ECO_DEPT_CODE

• Item Attributes Retrieved by Function - None

Standard Approval Notification (Node 3) :
This is a standard approval notification that requests approval from users on the 
approval list.

• Message - Standard Approval Message

• Result Type - ECO Approval

• Required - Yes

• Prerequisite Activities - Standard Approval Message

• Expand Roles - No

• Notification Function - None

Set MRP to Active (Node 4) :
After the user has approved the ECO, this function sets the MRP Active attribute to on 
for revised items with status of Open and Scheduled. This can be used to create MRP 
demand when the ECO's approval status is updated to Approved.
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• Function - ENG_WORKFLOW_API_PKG.SET_MRP_ACTIVE

• Result Type - None

• Required - Yes

• Prerequisite Activities - Standard Approval Notification

• Item Attributes Set by Function - None

• Item Attributes Retrieved by Function - None

Approve ECO (Node 5) :
This function sets the status of the ECO to Approved.

• Function - ENG_WORKFLOW_API_PKG.APPROVE_ECO

• Result Type - None

• Required - No

• Prerequisite Activities - Standard Approval Notification

• Item Attributes Set by Function - None

• Item Attributes Retrieved by Function - None

End (Approve) (Node 6) :
This function ends the ECO approval process with a status of Approved.

• Function - WF_STANDARD.NOOP

• Result Type - None

• Required - No

• Prerequisite Activities - None

• Item Attributes Set by Function - None

• Item Attributes Retrieved by Function - None

Set MRP Inactive (Node 7) :
After the user has rejected the ECO, this function sets the MRP Active attributes to off 
for revised items with status of Open and Scheduled.
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• Function - ENG_WORKFLOW_API_PKG.SET_MRP_INACTIVE

• Result Type - None

• Required - Yes

• Prerequisite Activities - Standard Approval Notification

• Item Attributes Set by Function - None

• Item Attributes Retrieved by Function - None

Reject ECO (Node 8) :
This function sets the status of the ECO to Rejected.

• Function - ENG_WORKFLOW_API_PKG.REJECT_ECO

• Result Type - None

• Required - No

• Prerequisite Activities - Standard Approval Notification

• Item Attributes Set by Function - None

• Item Attributes Retrieved by Function - None

End (Reject) (Node 9) :
This function ends the ECO approval process with a status of Rejected.

• Function - WF_STANDARD.NOOP

• Result Type - None

• Required - No

• Prerequisite Activities - None

• Item Attributes Set by Function - None

• Item Attributes Retrieved by Function - None

Defining Engineering Change Orders
An engineering change order (ECO) controls item revisions and bill of material changes.
ECOs specify changes to one or more items and each of these items can have one or 
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more revised components.

To define Engineering Change Orders:
1. Navigate to the Engineering Change Orders window.

2. Create the ECO. See: Creating an ECO, page 2-22.

3. Assign an ECO approval list and status. See: Viewing ECO Approval Status, page 2-
25.

4. Define implementation costs. See: Defining Implementation Costs, page 2-28.

5. Define an ECO revision. See: Defining an ECO Revision, page 2-29.

6. Define revised items. See: Defining ECO Revised Items, page 2-29.

7. Review ECO scheduling. See: Viewing ECO Schedule History, page 2-33.

8. Review item revisions. See: Viewing Item Revisions, page 2-34.

9. Define revised components. See: Defining Revised Components, page 2-39.

10. Review substitute components and reference designators. See: Assigning or 
Deleting Substitute Components, page 2-42 and Assigning Reference Designators, 
page 2-43.

11. Optionally, attach files to ECOs. See: Attaching Files to ECOs, page 2-43.

12. Submit the ECO for approval or set approval status to Ready to Approve.

13. Transfer or Copy the ECO to manufacturing See: Transfer to Manufacturing from 
an ECO page , page 2-44 and Copy to Manufacturing from an ECO page , page 2-
45.

Related Topics
Rescheduling an ECO or Revised Items, page 2-27

Changing the ECO Status, page 2-27

Implementing ECOs, page 2-48

Engineering Change Order Detail Report, page 4-1

Transferring or Copying Engineering Items, Bills, and Routings, page 3-5
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Creating an ECO 
An ECO's approval status must be Approved before the ECO can be implemented. 

Note: If the approval status is Approval Requested, you cannot modify 
the ECO. If the approval status is Approved and the ECO is modified, 
the approval status will be set back to Not Submitted for Approval.

When ECO types are defined, they can optionally be associated with a priority as they 
are being associated with an Oracle Workflow process. When creating the ECO, if the 
selected ECO type / priority combination matches a defined ECO type/priority 
combination, the associated workflow process defaults. The approval status is set to Not
Submitted for Approval until the Submit button is chosen. If there is no match between 
entered values and existing ECO type / priority combinations, the approval status is set 
to Approved and you can enter an approval list.

You can create, update and delete ECOs for the current organization, or for the current 
organization and all subordinate organizations in a given organization hierarchy.

You can use ECO propagate function to implement ECO in all eligibles across 
organization.

To create an ECO:
1. Navigate to the Engineering Change Orders window.
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2. Enter an alphanumeric ECO identifier. If you use ECO autonumbering, the next 
identifier is defaulted.

3. Enter or select an ECO type.

You can only select ECO types that can revise engineering items and bills if the 
ENG: Engineering Item Change Order Access profile option is set to Yes. If the 
selected ECO type updates engineering and manufacturing items and bills, any new
bills defined on the ECO are engineering bills.

4. Indicate whether to process the ECO across all organizations within the given 
organization hierarchy, or for the current organization.

Note: If the checkbox is clear, then the ECO applies to the current 
organization. If the checkbox is selected and a value is provided in 
the Organization Hierarchy field, then the ECO propagate function 
allows ECO to be applied to the current organization and all 
subordinate organizations under the given organization hierarchy 
structure.

Important:  The Organization Hierarchy driver fields apply to the 
ECO Header, ECO Revisions, Revised Items, Revised Components, 
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Reference Designators and Substitute Components.

5. Optionally, enter the requestor of the ECO.

6. Optionally, enter the ECO department responsible for the ECO.

This can be used to transition the ECO from one department to another, for 
example, from manufacturing engineering to operations. For new ECOs, the default
is derived from the ENG: ECO Department profile option.

If you specify that each ECO must have an ECO department, that is, the ENG: 
Mandatory ECO Departments profile option is set to Yes, then you must specify a 
responsible department.

Access to ECOs by ECO department is as follows:

• You can only view and update ECOs with the same ECO department as your 
ENG: ECO Department profile option.

• If you do not have a value for the profile option ENG: ECO Department, you 
can query and update any ECO.

• Any user can query and update ECOs with no department reference.

7. Optionally, enter a reason for the engineering change.

8. Optionally, enter or select a priority for the ECO.

Note: If the ECO type and the priority combination are associated 
with an Oracle Workflow process, you cannot use an approval list.

9. If a workflow process is not associated with the ECO, you can enter an approval 
list. If you do not enter an approval list, the ECO approval status defaults to 
Approved without any kind of approval process.

10. Optionally, enter the approval status for the ECO.

11. Choose the ECO Revisions button to define ECO revisions. See: Defining an ECO 
Revision, page 2-29.

12. Choose the Revised Items button to define revised items. See: Defining ECO 
Revised Items, page 2-29.

13. Select the ECO status from the Tools menu. See ECO Statuses, page 2-59. 

If the ECO status is Implement or Cancelled, the date of either status change is 
displayed.
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14. If a workflow process is associated with the ECO, choose the Submit button to start 
the process.

Related Topics
Defining ECO Types, page 1-6

Viewing ECO Approval Status, page 2-25

Changing the ECO Status, page 2-27

Implementing ECOs, page 2-48

Defining ECO Autonumbering, page 1-8

MRP Planning for ECOs, page 2-54

Unreleased Item Revisions in Oracle Work in Process, page 2-55

Implementation of ECOs on Discrete Jobs and Repetitive Schedules, page 2-55

Engineering Profile Options and Security Functions, page 1-15

Creating Organization Hierarchies, Using Oracle HRMS-The Fundamentals

Viewing ECO Approval Status 
If an approval list is used, the approval status can only be changed manually, pending 
formal approval from a list member. 

If a workflow process is associated with the ECO (based on the ECO type / priority 
combination), the approval status is changed automatically.

If neither a list nor a process is used, you must manually select either Approved or 
Rejected.

To view approval dates:
1. Select View Dates from the Tools menu. The approval request date, the approved 

date (if applicable), and the days to approve are displayed for reference. 
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To view workflow approval status:
1. If a workflow process is associated with an ECO, Select View Approvals from the 

Tools menu to view the approval status of the ECO. 

2. Highlight the desired Approval Process, and select the Status button.

Related Topics
Creating an ECO, page 2-22

ECO Approval Statuses, page 2-59

Workflow for ECO Approvals, page 2-9
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Rescheduling an ECO or Revised Items
You can reschedule ECOs or ECO revised items unless their status is Cancelled or 
Implemented.

Important: Rescheduling does not change the ECO or revised item 
status, only the dates.

To reschedule an ECO or Revised Items:
1. Choose Reschedule from the Tools menu from either the Engineering Change 

Orders window or the Revised Items window.

2. Do one of the following:

• If you are rescheduling an ECO, select an effective date from the calendar.

• If you are rescheduling revised items, select a use-up date.

3. Enter the requestor of the rescheduled ECO.

4. Choose OK to save your work.

If you entered this window from the Engineering Change Orders window, choosing
OK will reschedule all pending revised items (those with the status of Open, Hold, 
Schedule, or Release) for this ECO.

If you entered this window from the Revised Items window, this will reschedule 
only the selected revised item.

Related Topics
Overview of Function Security, Oracle Applications System Administrator's Guide

Implementing Function Security, Oracle Applications System Administrator's Guide

Changing the ECO Status 
You can change the ECO status and the ECO revised item's status to Open, Hold, 
Release, Schedule, Implement, or Cancel. 

The approval status of an ECO must be Approved before the ECO can be implemented.

The following table describes the conditions regarding Workflow under which the 
status can be changed:
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Status Without 
Workflow

With Workflow: 
Before 
Approval

With Workflow: 
After Approval

With Workflow: 
Approval in 
Process

Open Yes Yes Yes No

Hold Yes Yes Yes No

Released Yes Yes Yes No

Scheduled Yes No No No

Rescheduled Yes Yes Yes No

Cancel Yes Yes Yes No

Implement Yes No Yes No

To change the ECO status:
1. Navigate to the Engineering Change Orders window.

2. From the Tools menu, choose the status (Open, Hold, Release, Schedule, 
Implement, or Cancel). See: ECO Statuses, page 2-59.

3. If you are cancelling the ECO, select the Cancel Comments pop list to enter 
comments.

4. Save your work.

Related Topics
Implementing ECOs, page 2-48

Starting the AutoImplement Manager, page 1-14

Engineering Profile Options and Security Functions, page 1-15

Defining Implementation Costs 
Estimate the implementation costs to engineering and to manufacturing of the ECO. 
Oracle Engineering uses this information only for the purpose of reference.
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To define manufacturing and engineering costs:
1. Go to Tools menu and choose Enter Costs.

2. Enter a cost for engineering

3. Enter a cost for manufacturing.

Defining an ECO Revision 

To define an ECO revision:
1. Navigate to the ECO Revisions window. Do this by choosing the ECO Revisions 

button from the Engineering Change Orders window.

2. Enter a revision for the ECO.

The date that you entered the ECO is displayed for reference.

3. Save your work.

Defining ECO Revised Items 
Each ECO can list one or more revised items whose form, fit, or function needs revision.

Any revised item can have an associated bill of material. You can create a bill for a 
revised item (if one does not exist) by copying it from another bill or by adding 
components to it.

To define revised items:
1. 
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Navigate to the Revised Items window. Do this by choosing the Revised Items 
button from the Engineering Change Orders window.

2. Enter or select an item to change with this ECO.

Note: You can create a bill for the item (if one does not exist) by 
choosing the Components button and adding components in the 
Revised Components window.

3. Optionally, enter an alternate for the item. You can create or update alternate bills 
using an ECO.

4. Optionally, enter a new revision for the revised item.

This must be greater than or equal to the current revision. If you create or update an
alternate bill of material, you cannot assign a new item revision.

You must enter a new revision for the revised item if you set the ENG: Require 
Revised Item New Revision profile option to Yes.

5. Optionally, enter an item Description. 

You do not have the ability to enter an item description if you enter an alternate for 
the item.

6. Optionally, enter a Routing Revision.

This must be greater than or equal to existing revisions. You cannot enter any 
revisions if you selected a Model/Unit effectivity item in the Item field. If you 
entered a revised item that should not have routings, then the Routing Revision 
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field will be disabled.

7. Enter an effective date for the item and component changes.

This date is used to implement the revised item and identify past due revised items.

If you select a use-up date for this item and its components, a record is created that 
indicates this revised item is based on the use-up date of the item. If the MRP 
planning process computes a new use-up date before this revised item is 
implemented, Engineering automatically sends an alert to the planner.

8. Choose a status for the ECO revised item from the Tools menu. See: ECO Revised 
Item Statuses, page 2-59.

Note: You can set the revised item status to Hold, Released, 
Implemented, or Cancelled only if the ECO status is Open. 
Otherwise, the revised item status defaults from the ECO status.

If the ECO has a Workflow process and the item or its components are changed, the
revised item's status is changed from Scheduled to Open and the approval status is 
changed to Not Submitted for Approval.

9. Indicate whether the revised item is MRP Active, that included in the planning 
process. The default is No if the Status is Hold; Yes if the Status is Open, Release, or 
Schedule.

If the ECO lists engineering changes and has an effective date in the future, you 
may want the planning process to consider those changes.

10. Open the Item Details tabbed region and view the description and the user-defined 
item type for that item.

11. Optionally, open the Dates tabbed region and enter the Early Effective date. This is 
the earliest date you can manually implement the revised item.

If applicable, the Cancelled date for the changes of the revised item and its 
components, or the Implemented date for the revised item is displayed.

The Implemented field indicates the date the revised item was implemented and 
the Implemented By field indicates either that the revised item was implemented 
manually from the Tools menu or implemented automatically.

12. Open the Use Up Details tabbed region and do the following:

• If not already selected, enter the item whose use-up date is tied to the revised 
item effective date. The use-up item can be the revised item itself or a 
component of the revised item.

• View the use-up item associated with the use-up date selected as the effective 



2-32    Oracle Engineering User's Guide

date.

• View the name of the MRP plan to use for determining item use-up dates.

13. Open the Routing Details tabbed region and do the following:

• Indicate whether CTP is enabled. This attribute is derived from the routing 
header information if the revised item has existing routing information. If 
routing information does not exist, routing header information is created 
automatically when you enable this attribute.

• Enter a priority value for this item.

• Choose a valid subinventory. 

• Enter Locator information. If the completion subinventory does not have a valid
location, or the revised item's Locator Control attribute is set to No Control, 
then this field is disabled. If the revised item's Locator Control attribute is set to 
Dynamic Entry, then this field is enabled.

14. Open the Work in Process tabbed region and indicate whether to update WIP 
requirements for unreleased jobs or schedules when the revised item is 
implemented.

15. Select a disposition for inventory and work in process inventory affected by the 
ECO. See: Disposition, page 2-59.

16. Open the Cancel Details tabbed region to view the cancellation date and cancel 
comments.

17. Choose the History button to view revised item effective date history and track 
schedule changes to the revised item. Choose the Revisions button to view item 
revisions. Choose the Components button to add, change, or disable components.

Related Topics
Viewing ECO Schedule History, page 2-33

Defining Revised Components, page 2-39

Viewing Item Revisions, page 2-34

Use Up ECOs, page 2-53

Defining Material Dispositions, page 1-13
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Viewing ECO Schedule History 
View revised item effective date history and track schedule changes to revised items.

To view ECO schedule history:
1. Navigate to the History window. Do this by choosing the History button from the 

Revised Items window.

A history of all previous effective dates and their entry date is listed for the revised 
item.

2. View the employee who initiated the change to the effective date and any 
comments describing the change to the effective date.

Related Topics
Engineering Change Order Detail Report, page 4-1
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Viewing Item Revisions 

To view item revisions:
1. Navigate to the Item Revisions window. Do this by choosing the Revisions button 

from the Revised Items window.

2. Review the displayed information:

The revision, the effective date and time, the implementation date, the initiation 
date, and the ECO are displayed for information purposes.

Note: : When creating an item revision, to support revision 
identification, you can specify both Revision Code and Revision 
Label. You can then quickly review an item revision by selecting 
this combination from the Item Revisions drop down list in the 
Revisions page.

Related Topics
Defining ECO Revised Items, page 2-29

Viewing Routing Revisions

To view routing revisions:
1. Navigate to the Routing Revisions window. Do this by choosing the Routing 

Revisions button from the Revised Items window.
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2. Review the displayed information:

The revision, the effective date and time, the implementation date, and the related 
ECO are displayed for information purposes.

Related Topics
Defining Revised Components, page 2-39

Defining Revised Resources, page 2-37

Defining Revised Operations, page 2-35

Defining ECO Revised Items, page 2-29

Defining Revised Operations 
Enter, disable, and update information for a revised item's operations.

To define revised operations:
1. Navigate to the Revised Operations window. Do this by choosing the Operations 
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button from the Revised Items window.

2. Enter or select an action to take:

Add: Add an operation and the operation's resources. If there is no existing 
operation, then a new routing header should be created.

Change: Change operation attribute and resource information.

Disable: Disable the operation from the revised item's bill. The resources which are 
associated with the operation should be disabled.

3. Enter the Operation Sequence Number of the target operation. If you selected the 
Add action, enter a new operation sequence number. If you selected the Change or 
Disable actions, enter an existing operation sequence number.

4. Indicate whether this operation will be referenced if you selected the Add action. If 
you selected a standard operation, then this flag is turned on automatically. If you 
selected the Change action, then this flag is disabled.

5. Enter the Department Code. If you selected the Add action, or the Change action 
and a standard operation, enter an existing department code.

6. Enter the date the operation is to be disabled in the Disable Date field. If you 
selected the Disable action, the system date is entered automatically.

7. Indicate whether this operation is option dependent if you selected the Add action, 
or the Change action and did not select the reference flag.



Engineering Change Orders    2-37

8. Enter the Operation Lead Time if you selected the Add or Change actions. If an 
operation lead time is smaller than zero or greater than 100, then an error message 
will be shown.

9. Open the WIP tabbed region and enter the following attributes:

• If you selected the Add action, or the Change action and did not select the 
reference flag, you can update the Count Point flag.

• If you selected the Add action, you can update the Autocharge flag.

• If you selected the Add action, or the Change action and did not select the 
reference flag, you can update the Backflush flag.

• If you selected the Add action, or the Change action and did not select the 
reference flag, you can enter the Minimum Transfer Quantity.

10. Open the Operation Yield tabbed region and do the following:

• Enter the Yield if you selected the Add or Change actions. Operation Yield is 
applicable to lot-based jobs, and is used to track variances between estimated 
and actual scrap absorption. See: Defining a Department, Oracle Bills of Material 
User's Guide

• Enter the Cumulative Yield if you selected the Add or Change actions. See: 
Yield, Oracle Bills of Material User's Guide.

Note: These fields can be updated for operations belonging to 
lot-based routings, and are applicable for Shop Floor 
Management enabled organizations.

Related Topics
Defining Revised Components, page 2-39

Defining Revised Resources, page 2-37

Item and Operation Sequence, Oracle Bills of Material User's Guide

Effective Date Fields, Oracle Bills of Material User's Guide

Defining Revised Resources 
Enter or disable information for a revised operation's resources.

If the Reference Flag in the Revised Operations window is selected, then you cannot 
add or disable resources. 
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To define revised resources:
1. Navigate to the Operation Resources window. Do this by choosing the Revised 

Resources button from the Revised Operations window.

2. Enter or select an action to take:

Add: Add a resource to the operation.

Change: Change existing resource information.

Disable: Disable the resource from the operation. Designate an existing resource 
sequence number.

3. Enter the Resource Sequence Number. If you selected the Add action, enter a new 
resource sequence number. If you selected the Disable action, enter an existing 
resource sequence number.

4. Enter the Resource Code. If you selected the Add action, select a resource belonging
to the selected department in the Revised Operations window.

Note: The UOM field is derived from the Resource attribute and is 
read-only.

5. Enter the Basis Type. If you selected the Add or Change actions, select Item or Lot. 
See: Basis, Oracle Bills of Material User's Guide.
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6. Enter the Usage Rate or Amount if you selected the Add or Change actions. Once 
you enter or change this value, the Inverse will be calculated automatically.

7. Enter the Inverse Rate or Amount if you selected the Add or Change actions. Once 
you enter or change this value, the Usage will be calculated automatically.

8. Open the Scheduling tabbed region and do the following:

• Indicate whether this resource is available 24 hours. Once selected, you cannot 
update this value.

• If you selected the Add or Change actions, enter a Schedule Sequence Number.

• Enter the number of units assigned to this resource.

• Select the Schedule option. Available options are Yes, No, Prior, and Next.

• If you selected the Add or Change actions, enter the Offset percentage. This 
number should be greater than or equal to zero, and less than or equal to 100.

• Indicate whether this is the principle resource in the operation, if you selected 
the Add or Change actions.

• Enter the Setup Type Code for this resource.

9. Open the Costing tabbed region and do the following:

• Select an Action. You can Add or Change costing information. Costing 
information must be defined for each resource.

• Select whether to cost at the standard rate.

• Select a Charge Type if you selected the Add action. If you selected the Change 
action, you can change the Charge Type but cannot enter an autocharge type of 
PO Move or PO Receipt for a resource without Outside Processing enabled. 
You can select Manual or WIP Move.

Related Topics
Defining Revised Components, page 2-39

Defining Revised Operations, Oracle Engineering User's Guide

Item and Operation Sequence, Oracle Bills of Material User's Guide

Defining Revised Components 
Enter and update change information for a revised item's components.
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To define revised components:
1. Navigate to the Revised Components window. Do this by choosing the 

Components button from the Revised Items window.

2. Enter or select an action to take:

Add: Add a component to the revised item's bill of material. If a bill does not 
already exist, adding components creates one.

Change: Change usage information for the component of the revised item's bill.

Disable: Disable the component from the revised item's bill.

3. Enter a component on the bill.

4. Do the following:

• If you are changing component information, enter the old operation sequence 
where the component is currently assigned.

• If you are changing the component's operation sequence, enter a new operation 
sequence (from the routing) for the component of the revised item. The default 
is 1 for components being added where no routing exists.

• Enter the item sequence of the item on the bill of material. The default is the 
next highest item sequence.
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• Enter the component quantity used by this particular revised item. For 
components you are changing, you can see the old component's quantity in the 
Old Quantity field when you change or disable a component. In ECO form, 
when disabling a component the value in Old Quantity field is defaulted into 
New Quantity field, and 1 for components you are adding.

• For components you are adding or changing, enter an inactive date for the 
revised component.

5. Review the item's description, revision, and whether it is an engineering item in the 
Item Details tabbed region.

6. Open the Component Details tabbed region and do the following:

• Enter the planning percent for optional components on model and option class 
bills, and all components on planning bills. Oracle Master Scheduling/MRP uses
planning percentages for planning bill explosions. You can enter quantities over
100 percent to overplan. See: Planning Percent, Oracle Bills of Material User's 
Guide.

• Enter a component yield factor. You cannot enter component yield for an 
option class item or for any components of a planning bill. The default is 1, 
indicating 100% yield. See: Yield, Oracle Bills of Material User's Guide.

• Indicate whether to include the cost of this component in the cost of its parent 
item for the cost rollup.

• View the component item type and status.

7. Open the Material Control tabbed region and select a supply type, a subinventory, 
and a locator. See: Supply Type, Oracle Work in Process User's Guide and 
Subinventory and Locator, Oracle Bills of Material User's Guide.

8. Open the Order Entry tabbed region and do the following:

• Indicate whether to Check ATP. See: Check ATP, Oracle Bills of Material User's 
Guide.

• Indicate whether the component is optional and mutually exclusive. See: 
Mutually Exclusive and Optional, Oracle Bills of Material User's Guide.

• For optional components, enter the minimum and maximum sales order 
quantities. See: Minimum and Maximum Quantities, Oracle Bills of Material 
User's Guide.

• Select a basis. See: Basis, Oracle Bills of Material User's Guide.
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9. Open the Shipping tabbed region and indicate whether the component should be 
listed on shipping documents, required to ship, or required for revenue. See: 
Shipping Details, Oracle Bills of Material User's Guide.

10. If the component is cancelled, open the Cancel Details tabbed region. Once the 
component is cancelled, you can no longer update any information about the 
revised component on this ECO.

Note: You can cancel revised components by choosing Cancel from 
the Tools menu.

11. Choose the Substitutes button to open the Substitute Components window. Choose 
the Designators button to open the Reference Designators window.

Related Topics
Assigning Reference Designators, page 2-43

Assigning or Deleting Substitute Components, page 2-42

Item and Operation Sequence, Oracle Bills of Material User's Guide

Effective Date Fields, Oracle Bills of Material User's Guide

Assigning or Deleting Substitute Components 
Assign or delete suggested substitute items for the revised component. You can assign 
any number of substitute items to each bill component and you can assign the same 
substitute item to more than one component.

To assign or delete substitute components:
1. Navigate to the Substitute Components window. Do this by choosing the 

Substitutes button from the Revised Components window.

2. Enter an action: add a substitute item to, or delete a substitute item from the revised
component.

3. Enter or select a substitute item for the revised component. This must be a 
manufacturing item.

4. Enter the quantity of the substitute item needed to replace the full component 
quantity.

This can differ from the bill usage quantity of the component. The default is the 
usage quantity of the component.
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Assigning Reference Designators 

To assign reference designators to the revised component:
1. Navigate to the Reference Designators window. Do this by choosing the 

Designators button from the Revised Components window.

2. Indicate whether to relate component quantity to the number of reference 
designators.

Off: Assign any number of reference designators to each component (the default). 
The number of reference designators is independent of the component quantity. 
With Quantity Related unchecked, if the usage quantity of the component is four, 
you could, for example, define six or more reference designators.

On: Use one reference designator per usage of the component. The component 
usage quantity must be a positive integer in order for you to use this option. When 
the bill requires a quantity of four of a given component, you assign four reference 
designators to that component, one for each usage. 

The number of reference designators implemented for the revised component is 
displayed. This value is 0 until the ECO is implemented.

Also, the total number of reference designators currently defined for the revised 
component is displayed.

3. Select an action: add to or delete a range of reference designators from the revised 
component.

Engineering enables you to view a prefix, suffix, and number range to assign to a 
sequence of reference designators.

Related Topics
Creating Reference Designators, Oracle Bills of Material User's Guide

Attaching Files to ECOs
You can attach text and files, such as spreadsheets, graphics, and OLE objects to 
engineering change orders.

For example, an attached file may include comments, such as a graphical representation
of the bill structure or detailed instructions.

To attach files to ECOs:
1. From the Engineering Change Orders window, choose the Attachments icon.



2-44    Oracle Engineering User's Guide

Related Topics
Working With Attachments, Oracle Applications User's Guide

Transfer to Manufacturing from an ECO 
You can transfer engineering items, bills and routing to manufacturing from within an 
ECO. 

To transfer entities to manufacturing from within an ECO:
1. Navigate to the Engineering Change Orders window.

2. Select the Transfer Button from the Engineering Change Orders window.

3. Enter an Item and select Bill and Routing if applicable.

4. Enter the Effective Date of the item. 

5. Enter the Early Effective date if applicable.

6. Select the Revisions tabbed region.
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7. Select the Selections tabbed region.

8. Select the Selection Option from the list. The available selections are:

All: All past, current or future components and or operation steps associated with 
the assembly.

Current: All current components and or operation steps associated with the 
assembly that are effective on the Selection Date.

Future and Current: All current and future components and or operation steps 
associated with the assembly. 

9. Enter the Selection Date.

10. Enter the Unit Number if applicable.

11. Save your work.

12. Select the History button to view the transaction history.

Related Topics
Transferring or Copying Engineering Items, Bills, and Routings, page 3-5

Transfer or Copy from an ECO, page 2-7

Copy to Manufacturing from an ECO, page 2-45

Copying Bill and Routing Information, Oracle Bills of Material User's Guide

Copy to Manufacturing from an ECO 
You can copy engineering items, bills and routings to manufacturing from within an 
ECO. 

To copy entities to manufacturing from within an ECO:
1. Navigate to the Engineering Change Orders window.

2. Select the Copy Button from the Engineering Change Orders window.
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3. Enter an Item and select Bill and Routing if applicable.

4. Enter the Effective Date of the item. 

5. Enter the Early Effective date if applicable.

6. Select the Revisions tabbed region. For information on the Revisions tabbed region 
and the Alternates tabbed, See:Transferring or Copying Engineering Items, Bills, 
and Routings, page 3-5

7. Select the Selections tabbed region.

8. Select the Selection Option from the list. The available selections are:

All: All past, current or future components and or operation steps associated with 
the assembly.

Current: All current components and or operation steps associated with the 
assembly that are effective on the Selection Date.

Future and Current: All current and future components and or operation steps 
associated with the assembly. 
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9. Enter the Selection Date.

10. Enter the Unit Number if applicable.

11. Select the Manufacturing Items tabbed region.

12. Enter a new item name and description.

13. Save your work.

14. Select the History button to view the transaction history.

Related Topics
Transferring or Copying Engineering Items, Bills, and Routings, page 3-5

Transfer or Copy from an ECO, page 2-7

Transfer to Manufacturing from an ECO, page 2-44

Copying Bill and Routing Information, Oracle Bills of Material User's Guide
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Mass Changing ECOs
You can define a mass change to add, delete, or replace a component, alter a component
quantity or yield, or change other component information. You can mass change all 
using bills of material or choose a subset of bills by item range, item category, or item 
type.

Engineering lets you create an ECO based on your parent item and component criteria. 
A mass change ECO lists all using assemblies that meet your search criteria as revised 
items, and assigns all component changes as revised components. You can manage and 
implement each revised item, or the entire ECO, the same way you maintain revised 
items you manually assign to an ECO.

Note: In Bills of Material, mass changes take place immediately. 
However, in Engineering, an ECO is created that must be implemented 
to take effect.

To mass change ECOs:
1. Mass change the bills of material as needed. Be sure to set ECO options.

Related Topics
Engineering Profile Options and Security Functions, page 1-15

Mass Changing Bills of Material, Oracle Bills of Material User's Guide

Implementing ECOs
When you implement an ECO, each revised item's status is marked as "implemented"; 
you can no longer reschedule it. You can implement all revised items on an ECO, or 
implement each revised item on a different date. Engineering only lets you implement 
ECOs that do not have an approval status of Rejected, or do not have an ECO status of 
Hold or Cancelled. Once you implement an ECO or revised item, you can no longer 
make any revised item changes.

You can manually implement revised items on an ECO or you can automatically 
implement each revised item on its effective date. Engineering updates the actual 
implementation date for each revised item when it is implemented. When all of the 
revised items on an ECO have been implemented, the ECO is completely implemented 
and can be purged.

Engineering implements an ECO over time from the earliest revised item effective date 
to the latest revised item effective date. When you spread multiple changes across 
several ECOs, you should ensure that the effective date ranges for the ECOs do not 
overlap. For example, if you implement changes to a bill of material across many ECOs, 
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you should make sure that the revised item effective dates do not overlap. If you 
implement one change using the current revision, you should implement all other 
changes to the current revision before you implement changes against future revisions.

Important: You must implement new revisions in ascending order. If 
you implement a later revision for an item on one ECO, Engineering 
ensures that you implement any subsequent revisions for the item in 
ascending order.

Manual Implementation
For an ECO, you can specify whether to implement all or specific revised items. An 
ECO can be implemented today, but will not make the changes to the revised items 
effective until the date specified on the change order.

Automatic Implementation
To AutoImplement a revised item on an ECO, you mark the revised item status as 
'scheduled' and specify an effective date. You can schedule all revised items on an ECO 
for auto-implementation, or schedule each revised item individually. Engineering 
automatically implements scheduled changes on their effective dates. 

You can automatically implement scheduled ECOs in the current organization, or the 
current organization including all subordinate organizations. You have the ability to 
specify the organization hierarchy name, since the current organization can be accessed 
from more than one organization hierarchy. You can also automatically implement 
scheduled ECOs in all organizations having the same item master organization as the 
current organization, and if they are accessible by the user responsibility.

Start the AutoImplement Manager process so Engineering implements scheduled 
changes daily.

To manually implement an ECO:
1. Navigate to the Engineering Change Orders window.

2. Enter or select an ECO to implement.

3. Choose Implement from the Tools menu. Doing so automatically changes the status
of all revised items.

To manually implement a revised item on an ECO:
1. Navigate to the Revised Items window.

2. Select a revised item to implement.
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3. Choose Implement from the Tools menu.

Note: A warning message appears if the ECO does not have a 
Workflow process and the revised item's effective date is in the 
future.

To automatically implement an ECO:
1. Navigate to the Engineering Change Order window.

2. Enter or select an ECO to implement.

3. Set the ECOs status and/or the status of revised items to Scheduled.

4. Save your work.

5. Start the AutoImplement Manager.

The following parameters are provided:

• All Organizations

• Organization Hierarchy

Note: If the All Organizations parameter is set to Yes, then 
processing is done for all organizations having the same item 
master organization as the current organization. If All 
Organizations is set to No, and a value is provided in the 
Organization Hierarchy field, then processing is done for the 
current organization and all subordinate organizations. If the 
Organization Hierarchy field is left blank, then the ECO is 
implemented only for the current organization. For processing, 
an organization must be accessible by the user responsibility. 
You can specify a periodic schedule for the concurrent 
program. In this case, the user should set the processing 
interval, start date, and end date.

Related Topics
Engineering Profile Options and Security Functions, page 1-15

Starting the AutoImplement Manager, page 1-14

Implementation of ECOs on Discrete Jobs and Repetitive Schedules, page 2-55

Creating Organization Hierarchies, Using Oracle HRMS-The Fundamentals
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Cancelling ECOs and Revised Items 
You can cancel an entire ECO, a revised item on an ECO, or the individual revised 
components on an ECO before it is implemented. When you cancel an ECO, you can 
enter comments that explain the reason for cancellation. 

Cancelling an entire ECO cancels all the revised item changes and the changes to their 
associated revised components. Cancelling a specific revised item cancels only the 
changes that affect that item and its revised components. Once you cancel an ECO you 
cannot update it, but you can view a cancelled ECO.

Cancelling a revised component only affects that revised component for that revised 
item. The cancel date and comments about the cancelled component can be viewed in 
the Revised Components window, Cancel Details tab.

To cancel the entire Engineering Change Order:
1. Navigate to the Engineering Change Order window.

2. Find the ECO to cancel.

3. Choose Cancel from the Tools menu.

4. Save your work.

• Cancel the ECO, its revised items, and the associated revised components by 
choosing Cancel from the Tools menu.

• Cancel a revised item by choosing the Revised Items button on the Engineering 
Change Orders window, and choosing Cancel from the Tools menu.

• Cancel a revised component by choosing the Components button from the 
Revised Items window and choosing Cancel from the Tools menu.

5. Save your work.

To cancel an ECO's revised items:
1. Navigate to the Engineering Change Order window.

2. Find the ECO containing revised items to cancel.

3. Choose the Revised Items button.

4. Select the revised items to cancel.

5. Choose Cancel from the Tools menu.
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6. Save your work.

To cancel components of a revised item:
1. Navigate to the Engineering Change Order window.

2. Find the ECO containing components of revised items to cancel.

3. Choose the Revised Items button.

4. Select the revised item containing components to cancel.

5. Choose the Components button.

6. Select the components to cancel.

7. Choose Cancel from the Tools menu.

8. Save your work.

Related Topics
Engineering Profile Options and Security Functions, page 1-15

Creating an ECO, page 2-22

See Material Requirements Planning in the Oracle Master Scheduling/MRP User's 
Guide 

Viewing ECO Schedules 
View ECO information, including scheduling information, pending and implemented 
ECOs, approval status, revised item status, and so on.

To view ECO schedules:
1. Navigate to the View ECOs folder window.

2. Enter search criteria in the Find ECOs window

3. Select how to sort ECOs-by ECO identifier then effective date, or by effective date 
then ECO identifier.

4. Optionally, enter revised item information:

• An effective date range

• A revised item
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• A revised component

• Whether to query for revised item status, and if so, any combination of revised 
item statuses.

5. Choose the Find button to find ECOs based on your search criteria.

This opens the View ECOs folder window which has three tabbed regions, each 
containing specific ECO information: Revised Items, ECO Details, and Use Up.

6. Choose the New and Open buttons to navigate to the Engineering Change Orders 
window. Using the New button enables you to create a new ECO; using the Open 
button enables you to view an existing ECO.

Related Topics
Using Query Find, Oracle Applications User's Guide

Using Query Operators, Oracle Applications User's Guide

Searching For Information, Oracle Applications User's Guide

Performing Query-by-Example and Query Count, Oracle Applications User's Guide

Defining Engineering Change Orders, page 2-20

Customizing the Presentation of Data in a Folder, Oracle Applications User's Guide

Use Up ECOs
Oracle Master Scheduling/MRP automatically computes and stores the use-up date for 
each item it plans on each MRP plan. The use-up date is the date when on-hand 
quantity is exhausted based on projected gross requirements. It calculates the use-up 
date by applying any on-hand quantity in inventory (supply) against any gross 
requirements (demand). When calculating the date, it does not consider scheduled 
receipts or repetitive schedules as supply.

Revised Item Effective Dates Linked to Use-Up Dates
When you define a revised item on an ECO, you can base the revised item effective date
on the use-up date of another item.

When you define a revised item on an ECO, you can select the use-up date for all 
components of the revised item and the use-up date of the revised item itself for all 
MRP plans that include those items. Doing so will default the plan name and use-up 
item. The revised item effective date is now linked to a use-up date.

Alternatively, for a revised item, you can select a use-up item, which can be any 
component of the revised item or the revised item itself. But since the plan name is not 
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specified, the revised item effective date is not linked to a use-up date.

Use-Up Alerts
Engineering uses Oracle Alert to automatically notify planners whenever the MRP 
planning process computes a new use-up date for an item if it is a use-up item for an 
ECO revised item. For example, if revised item A specifies item B as its use-up item (so 
the revised item effective date for A equals B's use-up date), then if the MRP planning 
process computes a different use-up date for B, Oracle Alert notifies the planner for A 
that B's use-up date no longer equals the revised item effective date for A.

Related Topics
Creating an ECO, page 2-22

Overview of Planning Logic, Oracle Master Scheduling/MRP User's Guide

Reviewing the Horizontal Plan, Oracle Master Scheduling/MRP User's Guide

MRP Planning for ECOs 
Oracle Master Scheduling/MRP lets you consider unimplemented ECOs when you plan 
material requirements and considers use-up date changes in some cases.

Unimplemented ECO Revised Items Planning
When you define an ECO, specify whether the MRP planning process should plan for 
an ECO revised item. This lets you order material and plan resources that you need to 
build a future revision in advance. When the MRP planning process explodes 
requirements for a planned order based on a planned order start date, it generates 
requirements considering component changes introduced on ECO revised items so 
specified.

Use-up ECOs Planning
The planning process automatically changes revised item effective dates and considers 
those new effective dates in the current MRP plan only when the use-up date changes 
and the revised item is the use-up item. The planning process then uses the updated 
effective date for component changes when it explodes requirements for planned 
orders. 

Related Topics
Material Requirements Planning, Oracle Master Scheduling/MRP User's Guide
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Unreleased Item Revisions in Oracle Work in Process
In Work in Process, you can open discrete jobs or schedules considering pending 
engineering changes. Each user can define a job with released, scheduled, and 
implemented engineering changes, but you can control whether a user or a 
responsibility can define a job considering unreleased engineering changes.

If you set the WIP: Exclude Open ECOs profile option to Yes, Work in Process sees the 
effects of only released, scheduled, and implemented ECO revised items when you 
choose a revision or revision date and when Work in Process explodes the bill of 
material. Work in Process also considers open (unreleased) ECOs if you set this profile 
option to No.

Related Topics
Overview of Discrete Manufacturing, Oracle Work in Process User's Guide

Overview of Repetitive Manufacturing, Oracle Work in Process User's Guide

Implementation of ECOs on Jobs and Schedules
You can indicate whether to update work in process requirements when you implement
an ECO revised item. When you implement the revised item that is set to update work 
in process, the bill of material is automatically re-exploded and updated for all 
unreleased discrete jobs and repetitive schedules for the item.

If you have updated component material requirements for the unreleased job or 
schedule, you lose these updates after you implement the revised item. 

Released, Complete, and On hold Repetitive Schedules
For repetitive schedules, if you have not moved assemblies beyond the Queue 
intraoperation step of the first operation, Work in Process automatically regenerates the 
bill and component requirements for the repetitive schedule to include the effects of the 
ECO.

If you have moved assemblies beyond the Queue intraoperation step of the first 
operation, when you implement the ECO, Work in Process splits the schedule into two 
schedules that take the place of the original schedule. The first schedule uses the 
original bill and the second new schedule uses the revised bill that includes any revised 
item or component changes. Work in Process assigns the two new schedules a status of 
Released, Complete, or On hold, depending on the status of the original schedule. 

The schedule splits based on the number of assemblies in process (moved past the 
Queue intraoperation step of the first operation if you are using routings) on the 
original routing. That number is rounded up to the nearest day so that you can finish 
your day's work using the original bill. The next day production starts using the revised
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bill and a new schedule.

The following example best illustrates this procedure. 

Example
Released Schedule:

• Production rate = 50 per day 

• Process days = 4 days 

• Total quantity of schedule = 200 units

• Throughput = 1 day 

The following diagram illustrates the original schedule:

Shop floor distribution of assemblies before the implementation of the ECO for the 
original schedule: 

• 80 units spread in the routing beyond queue of the first operation 

• 120 units in queue of the first operation 

Original schedule dates: 

• First unit start date = Day 1 



Engineering Change Orders    2-57

• First unit complete date = Day 2 

• Last unit start date = Day 4 

• Last unit complete date = Day 5 

Since the daily quantity is 50, this means that production is in its second day. Therefore,
if you implement the ECO now, the schedule splits after the second day's work is 
completed.

If you implement a change order for the item on Day 3 (Today), the shop floor 
distribution of assemblies following the implementation of the ECO are: 

New Schedule 1 = 100 total units 

• 20 units in queue of the first operation 

• 80 units spread in the routing beyond queue of the first operation. These 80 units 
are located exactly where they were before the implementation of the ECO. 

New Schedule 2 = 100 total units 

• 100 units in queue of the first operation. The reason that there are only 100 
assemblies and not 120 assemblies is that only two process days remain in the 
schedule; therefore, only two process days worth of assemblies can be put into new 
schedule 2. 

Schedule dates following the implementation of the ECO: 

New Schedule 1: 

• First unit start date = Day 1

• First unit complete date = Day 2

• Last unit start date = Day 2 

• Last unit complete date = Day 3

New Schedule 2: 

• First unit start date = Day 3 

• First unit complete date = Day 4

• Last unit start date = Day 4 

• Last unit complete date = Day 5

The following diagram illustrates the split schedule:
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All material that you issued to the original schedule remains with new schedule 1. 
Material requirements for new schedule 1 are changed to match the new number of 
assemblies to complete. Material requirements for the altered assembly are exploded for
new schedule 2 for the number of assemblies assigned to the new schedule 2. 

Related Topics
Overview of Discrete Manufacturing, Oracle Work in Process User's Guide

Overview of Repetitive Manufacturing, Oracle Work in Process User's Guide

Purging ECOs
You can purge fully implemented engineering change information from the database. 
You can choose a range of ECOs and a date. Engineering purges all fully implemented 
or cancelled ECOs on or before that date. 

When you purge ECOs, Engineering removes all implemented and cancelled ECOs as 
of that date from the database, along with all related information (except for the 
revision history of the bill itself). You cannot view or report ECO information once you 
purge it. 

To purge an ECO:
1. Navigate to the Purge Engineering Change Order window. See: Submitting a 

Request, Oracle Applications User's Guide.
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2. Enter a range of ECOs to purge.

3. Indicate whether to purge implemented ECOs.

4. Indicate whether to purge cancelled ECOs.

5. Enter a date on or before which all implemented and/or cancelled ECOs are purged.

Engineering Change Orders Field Reference
This section describes the use of certain major fields.

ECO Statuses
Whenever this status is updated, the status of all revised items is also updated.

Open The ECO is not complete; you can still make 
changes. MRP Active is defaulted to on.

Hold The ECO cannot be implemented. The status 
of all pending revised items is set to Hold. 
MRP Active defaults to off.

Release The entire ECO is released from the currently 
responsible ECO department. The status of all 
pending revised items is set to Released. MRP 
Active defaults to on.

Schedule The ECO is scheduled for 
auto-implementation. An ECO can only have 
this status if the approval status is Approved. 
MRP Active defaults to on.

Implement The ECO is implemented manually. You can 
no longer make changes to an implemented 
ECO.

Cancel No more changes allowed. All 
unimplemented revised items are cancelled.

Note: If the organization hierarchy is selected when creating an ECO, the ECOs having 
approval process will be propagated with an 'Open' status.
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ECO Revised Item Statuses
These statuses are updated by changes to the ECO status.

Open Changes to the revised item are still in process
or not complete. The MRP active attribute will
be updated to Yes. This is the default.

Hold Changes to the revised item are on hold; you 
cannot implement them.

Release Changes to the revised item have been 
released and can be implemented manually. 
The revised item has not been scheduled for 
auto-implementation.

Schedule The revised item is scheduled for 
auto-implementation. You can only set the 
revised item to Schedule if the ECO status is 
Approved. The MRP active attribute is 
updated to on.

Implement The revised item has been implemented 
manually or automatically. You cannot list 
additional changes for implemented revised 
items.

Cancel The revised item has been cancelled.

ECO Approval Statuses
If you do not tie an Oracle Workflow process to the ECO, the only valid approval status 
is No Approval Needed.

Not Submitted for Approval The ECO has not been submitted to the 
Workflow approval process.

Approval Requested Engineering has started the Workflow 
process.

Rejected Cannot schedule or implement the ECO or 
any revised items.
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Approved Approved for release, to schedule, or to 
implement.

Processing Error Indicates that an error occurred while 
Workflow was processing the ECO approval.

Ready to Approve Generate an approval Alert. 

Disposition Field
These values describe the disposition of inventory and work in process inventory 
affected by an engineering change order (ECO).

No change required The ECO does not affect the revised item in 
WIP and inventory. This is the default.

Scrap WIP and inventory Scrap the revised item in WIP and inventory 
when you implement the revised item.

Scrap only inventory Scrap the revised item only in inventory when
you implement the revised item.

Scrap only WIP Scrap the revised item only in WIP when you 
implement the revised item.

Rework inventory and WIP Rework the revised item in WIP and 
inventory when you implement the revised 
item.

Rework only inventory Rework the revised item only in inventory 
when you implement the revised item.

Rework only WIP Rework the revised item only in WIP when 
you implement the revised item.

Exhaust WIP and inventory Use the revised item until you exhaust WIP 
and inventory for the item.

Exhaust only WIP Use the revised item until you exhaust WIP 
for the item.



2-62    Oracle Engineering User's Guide

Exhaust on serial number Use the revised item until it reaches a 
particular serial number.
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3
Engineering Prototypes

Overview of Engineering Prototype Environment
Oracle Engineering enables you to move toward concurrent engineering by integrating 
engineering prototype data with manufacturing data. Each department that accesses 
engineering item information can perform the same functions on prototypes as all 
departments do for manufactured assemblies. With engineering item information, you 
can separate released product designs, controlled distribution products, and alternate 
manufacturing methods for existing products from your manufacturing data.

Engineering enables you to create engineering items, bills of material and routings the 
same way you define manufacturing item information. 

Note: This does not apply to Product Families. See: Creating a Product 
Family, Oracle Bills of Material User's Guide

Each item defined in Engineering is assigned to engineering. You can define 
engineering items and assign item attribute details as you do for manufacturing items. 
You can perform any function with an engineering item that you do for a 
manufacturing item, including:

• Revision control

• Track inventory 

• Value inventory transactions

• Rollup costs

• Update frozen standard costs

• Plan in MPS and MRP
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• Sell on customer orders

• Purchase on purchase orders

• Build in WIP and issue to a WIP job

Item Catalog for Group Technology
When you design new products, search for existing items that meet your requirements 
before you define a new engineering item. Doing so can help prevent duplicate items. 
When you define an engineering or manufacturing item, you can classify the item by 
any number of characteristics.

For example, you can catalog manufacturing items and engineering items by three 
descriptive elements-form, fit, and function. Before you create a new engineering item, 
search the item catalog for all items that match any combination of these elements, such 
as "heated plastic" and "fastener". You can further restrict your search with other item 
details, including organization, item type, item category, and item status. If an item that
meets your search criteria does not exist, you can create a new engineering item and 
assign the values of "heated plastic" to form and "fastener" to function. See: Overview of 
Item Catalogs, Oracle Inventory User's Guide.

Engineering Item Status
You can define item statuses for each phase of your product life cycle. Engineering 
enables you to control engineering item attribute information by item status, so you can 
manage the introduction of new products. For example, you may define an item status 
"Design Released" and assign this status to all engineering product designs released 
from Design Engineering to your organization. You can control a "Design Released" 
item so that it cannot be built, purchased, or sold. As your product design matures, you 
can assign an item status of "Alpha" to your item so you can build or purchase it, but 
not include it on customer orders. After the product design and process stabilize, you 
may assign a "Beta" item status to your item so you can build, purchase, and sell the 
item in small quantities. See: Defining Item Status Codes, Oracle Inventory User's Guide.

Engineering Item Costing
You can specify item costs, roll up costs, and update frozen standard costs for 
engineering items. When you assign item costs, you can specify cost elements, 
sub-elements, activities, basis and rates, the same way you assign costs for 
manufacturing items. Oracle Cost Management lets you roll up and update 
manufacturing and engineering item costs by item, category, or across all items. After 
you assign, roll up, and update item costs, you can review cost information for all cost 
types available to engineering. You can restrict access to item cost details in Engineering
by cost type.
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Engineering Item Purchasing
For each engineering item you define, you can enable the item for use in Oracle 
Purchasing. To include engineering items on your purchase orders and requisitions, 
you can assign default buyer, supplier, price tolerance, and account information the 
same way you assign purchasing details to manufacturing items. You can receive, 
return, or adjust engineering items the same way you receive manufacturing items on 
purchase orders. For costed engineering items, you can track purchase price and 
compute purchase price variance the same way you cost other purchased items. With 
item status control, Engineering also enables you to control purchasing functions at any 
point in an engineering item's life cycle.

Engineering Item Planning
Engineering enables you to plan engineering items in Oracle Master Scheduling/MRP 
the same way you plan manufacturing items. When you define an engineering item, 
you can assign a MPS/MRP planning method, planning time fence, shrinkage rate, and 
other planning details. In Master Scheduling/MRP, you can forecast engineering items 
and manufacturing items, load forecast details, and consume forecasts with existing 
sales orders. Master Scheduling/MRP computes material requirements for engineering 
and manufacturing items using the master schedule, engineering or manufacturing bills
of material, scheduled receipts, and inventory information. You can also control 
planning functions for engineering items by item status to track an engineering item's 
life cycle. .

Discrete Jobs for Engineering Items
When you define an engineering item, you can enable the item for use in Oracle Work 
in Process. To build an engineering assembly or prototype a new process, you define a 
discrete job using an engineering bill of material or routing. You can issue engineering 
and manufacturing items to jobs, as well as collect resource, material, and overhead 
costs based on an engineering routing. You can place finished engineering assemblies 
into inventory the same way you place manufacturing assemblies into inventory. To 
track an engineering item's life cycle, you can update item status and control when to 
build an engineering item or prototype a new process in Work in Process.

Item Types and Bills of Material Types
Each item can be identified as an engineering item and enabled for use in Engineering 
using two item master attributes, Engineering Item and BOM Item Type. The BOM 
Allowed item attribute must also be set to Yes.

The Engineering Item attribute indicates whether the item exists in engineering. If not, it
is a manufacturing item. This attribute is not updatable when defining the engineering 
item. When an item is transferred to manufacturing, the Engineering Item attribute is 
disabled.
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You can enable any item for use in Engineering when you assign one of the following 
four values for the BOM Item Type item attribute: standard, model, option class, or 
planning.

You can define an engineering item and an engineering bill of material for a 
manufacturing item enabled in Oracle Bills of Material, but you cannot define 
manufacturing bills of material for engineering items.

Engineering Bills of Material and Routings
You can define an engineering bill of material or routing as alternates for a 
manufacturing bill or routing. This enables you to prototype variations from the 
primary bill of material that produce the same assembly.

You can specify a list of item catalog descriptive elements for model and option class 
engineering bills. After you release the engineering bill to manufacturing and take 
customer orders for specific configurations, Bills of Material creates the new 
configuration item and automatically assigns values to each catalog descriptive 
element.

Engineering lets you assign manufacturing and engineering items as components to the 
engineering bill of material. 

Each routing you define can exist either in engineering or in manufacturing, and both 
engineering and manufacturing routings share the same resource, department, and 
standard operation information.

You can calculate manufacturing and cumulative lead times for engineering items.

ECOs on Engineering Items and Bills
Engineering enables you to define engineering change orders (ECOs) for manufacturing
and engineering items. You can also mass change engineering bills of material the same 
way you manage mass changes to manufacturing bills of material.

ECO Types
Engineering controls the access to ECOs and the changes you can specify on an ECO. 
For each ECO type, you can specify if ECOs of this type can update engineering items. 
Only users whose profile option indicates they can update engineering items can choose
ECO types that update engineering item information. If you define a new bill of 
material using an ECO with an ECO type that updates engineering items, Engineering 
creates the bill as an engineering bill when you implement the ECO.

Profile Options
Engineering uses the following four profile options to control the types of items you can
change on an ECO: 
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• ENG: Engineering Item Change Order Access (engineering items)

• ENG: Model Item Change Order Access (model and option class items)

• ENG: Planning Item Change Order Access (planning items)

• ENG: Standard Item Change Order Access (standard items)

Related Topics
Creating an ECO, page 2-22

Defining ECO Types, page 1-6

Engineering Profile Options and Security Functions, page 1-15

Transferring or Copying Engineering Items, Bills, and Routings
You must transfer an engineering item prior to, or simultaneously with, its engineering 
bill of material and/or routing. When copying items, bills, and routings, all information 
must be copied simultaneously.

Note: Engineering does not transfer or copy an item, bill, or routing if it
already exists in manufacturing. Also, information transferred to 
manufacturing is still available to engineering; it is not copied.

Transferring and copying engineering data is organization specific. That is, you can 
only transfer or copy an engineering item, bill, or routing to manufacturing within the 
same organization. 

Engineering Items
All information associated with the engineering item is transferred or copied. 

If you copy an engineering item, you must provide a new name and description. The 
original item information is retained in engineering.

When you transfer an engineering item assigned to a category set different from the 
inventory category set, Engineering automatically assigns the new manufacturing item 
to the inventory category set. Engineering also enables you to assign a new item 
revision and lets you reference an ECO when you transfer an engineering item.

Engineering Bills of Material
All bill information-including all engineering item components on a single level bill for 
an item is transferred (or copied). For multiple levels of engineering item components, 
you must transfer each engineering bill level by level, starting from the lowest level.
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You can assign a new item revision and reference an ECO when you transfer an 
engineering bill of material. When you transfer an engineering bill of material, you can 
specify whether to transfer all components, current effective components, or current 
and future effective components. You can also specify whether to transfer pending 
component information from an ECO.

With this transfer criteria, Engineering transfers all engineering items that meet your 
criteria and that are components on the single level bill of material. For bills of material 
that reference a common engineering bill, you must transfer the common bill to 
manufacturing before you transfer any engineering bills that reference the common bill.

Note: This is applicable for ECOs in the tabbed region and for 
Transfer/Copy specific to Engineering Prototypes.

Engineering Routings
When you transfer a bill of material without transferring the engineering routing, all 
components on the manufacturing bill report to the operation sequence 1, regardless of 
the operations on the engineering routing. If components of the bill of material overlap 
(the same component item appears twice) at operation sequence one, Engineering does 
not transfer the engineering bill of material until you also transfer the engineering 
routing. If you transfer the engineering bill of material and routing simultaneously, 
components on the manufacturing bill report to the appropriate operation on the 
manufacturing routing.

When you transfer a routing, you can also specify a new routing revision and reference 
an ECO. Engineering transfers all operations, current effective operations, or future 
effective operations depending on your transfer criteria. For routings that reference a 
common engineering routing, you must transfer the common routing to manufacturing 
before you transfer any engineering routings that reference the common routing.

Note: This is applicable for ECOs in the tabbed region and for 
Transfer/Copy specific to Engineering Prototypes.

1. Navigate to the Transfer to Manufacturing window.
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2. Enter an item and indicate whether to transfer (or copy) item, bill, and routing data 
(if applicable).

Note: When copying an engineering bill to manufacturing, you 
must copy the item simultaneously with its bill and/or routing.

3. Optionally, enter a new item or routing revision (if applicable).

The revision must be higher than the current revision (as shown) and can be 
alphanumeric.

4. Optionally, open the Alternates tabbed region and for Selection, select Specific to 
transfer (or copy) a specific alternate, select Primary to transfer the primary 
alternate, or select All to transfer all alternates.

Leaving this blank will transfer (or copy) the primary and all alternates (if any).

To transfer (or copy) a specific alternate, you must enter its name.

5. Open the ECO, Description tabbed region and enter an ECO. This is for 
informational purposes only.
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6. If you are copying data, you must open the Manufacturing Items tabbed region and
enter a new item name and description.

7. Choose the Transfer (or Copy) button.

8. If you are transferring (or copying) bills, indicate if only implemented components 
should be transferred.

9. Select whether to transfer (or copy) All past, Current (effective on the specified 
revision date), or Future components and/or operation steps associated with the 
assembly. The default is Current. If you select Current or Future and Current, enter 
an effective date.

Related Topics
Transfer or Copy from an ECO, page 2-7

Transfer items to manufacturing from an ECO, page 2-44

Copying Bill and Routing Information, Oracle Bills of Material User's Guide
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4
Reports

Engineering Change Order Approval Lists Report 
This report lists the approvers for engineering change orders (ECOs). When you change
the approval status of an ECO to Ready to Approve, Oracle Alert automatically sends 
an alert to each approver on the list indicating that an ECO awaits their approval.

Report Submission
In the Submit Requests window, select Engineering Change Order Approval Lists 
Report in the Name field. 

Approval List Names From/To 
To restrict the report to a range of approval list names, select beginning and ending 
approval list names. 

Related Topics
Submitting a Request, Oracle Applications User's Guide

Engineering Change Order Detail Report 
This report contains current or historical engineering change order (ECO) information. 
You can sort the report by engineering change notice or creation date. You can report all
changes, current pending changes, or historical changes. You can run the report for all 
engineering change notices or for a range.

Report Submission
In the Submit Requests window, select Engineering Change Order Detail Report in the 
Name field. 
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All Organizations 
Choose one of the following options:

No Report ECO information for the current 
organization. 

Yes Report ECO information for all organizations 
having the same item master organization as 
the current organization, and for those 
organizations accessible by the user 
responsibility. 

Organization Hierarchy 
Enter a valid organization hierarchy name from the list of values. If the value for the All
Organizations parameter is set to No, and you have provided a value for the 
Organization Hierarchy parameter, then the report will provide ECO information for 
the current organization and all organizations below the current organization in the 
specified organization hierarchy. If this parameter is left blank, and the All 
Organizations parameter is set to No, then the report will provide ECO information for 
the current organization. You can enter a value in this field only if you have entered No 
in the All Organizations field.

Engineering Change Orders From/To
To restrict the report to a range of engineering change orders, select the beginning and 
ending engineering change orders. 

Dates From/To 
To restrict the report to a range of dates, select the beginning and ending dates. 

Status 
Enter Open, Hold, Scheduled, Cancelled, Implemented, or Released to indicate the 
status of the ECO to print. See: ECO Statuses, page 2-59.

Additional Component Detail
Enter Yes or No to indicate whether to print ECO component detail.
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Order Entry Component Detail
Enter Yes or No to indicate whether to print ECO order entry component detail.

Related Topics
Creating Organization Hierarchies, Oracle Bills of Material User's Guide

Submitting a Request, Oracle Applications User's Guide

Engineering Change Order Priorities Report 
This report lists engineering change order (ECO) priorities that you defined for Oracle 
Engineering. ECO priorities enable you to specify the urgency of your ECO. 
Engineering uses ECO priorities for reference only.

Report Submission
In the Submit Requests window, select Engineering Change Order Priorities Report in 
the Name field. 

Related Topics
Submitting a Request, Oracle Applications User's Guide

Engineering Change Order Reasons Report 
This report lists the engineering change order (ECO) reasons that you defined for 
Oracle Engineering. You can use engineering change reasons to categorize your ECOs. 
Engineering uses ECO reasons for reference only.

Report Submission
In the Submit Requests window, select Engineering Change Order Reasons Report in 
the Name field. 

Related Topics
Submitting a Request, Oracle Applications User's Guide

Engineering Change Order Schedule Report 
This report lists pending engineering change order (ECO) schedule information up to a 
specified date. You can run the report for all ECOs or for a range.
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Report Submission
In the Submit Requests window, select Engineering Change Order Schedule Report in 
the Name field. 

Print Components 
Enter either Yes or No to indicate whether you want to print revised components 
associated with the revised item.

Engineering Change Order Type
Enter an engineering change order type to print engineering change orders associated 
with it.

Engineering Change Orders From/To
To restrict the report to a range of Engineering Change Orders, select the beginning and
ending Engineering Change Orders. 

Effective Dates From/To 
To restrict the report to a range of dates, select the beginning and ending dates. 

Revised Item Status 
Enter Open, Hold, Scheduled, Cancelled, Implemented, or Released to indicate the 
status of the revised item to print.

Display Option 
Choose one of the following options:

All Report the pending and implemented 
engineering change orders.

Historical changes Report the implemented engineering change 
orders. 

Pending changes Report the current engineering change orders. 
Oracle Engineering displays this option as the 
default. 
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Revised Item 
Enter a revised item to print.

Revised Component 
Enter a revised component to print.

Sort Criteria 1 
Choose one of the following options. The report sorts ECOs first in this order, then in 
the specified order for Sort Criteria 2 and Sort Criteria 3. 

ECO Sort ECOs first by ECO. Oracle Engineering 
displays this option as the default.

Effective date Sort ECOs first by effective date.

Item number Sort ECOs first by item number.

Sort Criteria 2 
Choose one of the following options. Engineering sorts the ECOs by the first sort type 
and then by this sort type within the first type. 

ECO Sort ECOs by ECO. 

Effective date Sort ECOs by effective date.

Item number Sort ECOs by item number. Oracle 
Engineering displays this option as the 
default.

Sort Criteria 3 
Choose one of the following options. Engineering sorts the ECOs by the first sort type, 
then by the second sort type within the first type, and finally by this sort type within the
second type. 
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ECO Sort ECOs by ECO. 

Effective date Sort ECOs by effective date. Oracle 
Engineering displays this option as the 
default.

Item number Sort ECOs by item number.

Related Topics
Submitting a Request, Oracle Applications User's Guide

Engineering Change Order Types Report 
This report lists the change orders types that determine the types of items and bills of 
material you can modify on engineering and mass change orders.

Report Submission
In the Submit Requests window, select Engineering Change Order Types Report in the 
Name field. 

Related Topics
Submitting a Request, Oracle Applications User's Guide
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A
Engineering Windows and Navigator Paths

Engineering Windows and Navigator Paths

For windows described in other manuals:

See... Refer to this manual for a complete 
window description.

BOM Oracle Bills of Material User's Guide

CAP Oracle Capacity User's Guide

CST Oracle Cost Management User's Guide

Flex Oracle Applications Flexfields Manual

GL Oracle General Ledger User's Guide

HR Oracle Human Resources User's Guide

PO Oracle Purchasing User's Guide

MRP Oracle Master Scheduling/MRP User's Guide

SYS Oracle System Administrator's Guide

User Oracle Applications User's Guide

Text in brackets ([ ]) indicates a button.
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The following table presents window names and navigation paths.

Engineering Responsibility

Window Name Navigation Path

Approval Lists, page 1-12 Setup > Approval Lists

Assign Cross Reference Types (See INV) Prototypes > Items > Cross References > 
[Assign]

Bill Components Comparison (See BOM) Prototypes > Bills > Comparison

Bill Details (See BOM) Prototypes > Bills > Bills > [Bill Details

Bill Documents (See BOM) Prototypes > Bills > Documents

Bills of Material (See BOM) Prototypes > Bills > Bills

Calculate Lead Times (See BOM) Prototypes > Routings > Lead Times

Change Types, page 1-6 Setup > Change Types

Change Type Processes, page 1-6 Setup > Change Types > [Processes]

Component Changes, page 2-48 ECOs > Mass Changes > [Changes]

Component Changes (See BOM) Prototypes > Bills > Mass Changes > [Changes]

Copy to Manufacturing, page 3-5 Protoyptes > Copy to Manufacturing

Copy to Manufacturing: from within an ECO 
page , page 2-45

ECOs > ECOs > [Copy]

Cross Reference Types (See INV) Prototypes > Items > Cross References

Deletion Constraints (See BOM) Setup > Delete Constraints

Departments (See BOM) Prototypes > Routings > Departments

Descriptive Elements (See BOM) Prototypes > Bills > Bills > [Elements]
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Window Name Navigation Path

ECO Autonumbering, page 1-8 Setup > AutoNumbering

ECO Department (See HR) Setup > ECO Department

ECO Priorities, page 1-10 Setup > Priorities

Engineering Change Orders, page 2-20 ECOs > ECOs ECOs > Schedules

Engineering Master Item (See INV) Prototypes > Items > Master Items

Engineering Organization Item (See INV) Prototypes > Items > Organization Items

Enter Person (See HR) Setup > Employees

History, page 2-33 ECOs > ECOs > [Revised Items] > [History]

Import Bills and Routings (See BOM) Prototypes > Bills > Import

Indented Bill of Material (See BOM) Prototypes > Bills > Indented Bills

Item Attributes (See INV) Prototypes > Items > View Item Details > 
[Attributes]

Item Catalog Groups (See INV) Prototypes > Items > Catalog Groups

Item Documents (See User) Prototypes > Items > Documents

Item Relationships (See INV) Prototypes > Items > Related Items > [Find]

Item Revisions, page 2-34 ECOs > ECOs > [Revised Items] > [Revisions]

Item Revisions (See BOM Prototypes > Bills > Bills > [Revision]

Item Search (See INV) Prototypes > Items > Item Search > [Find]

Item Template (See INV) Prototypes > Items > Item Template > [Find] > 
Item Templates Summary > [Open]

Item WhereUsed (See BOM) Prototypes > Bills > Item WhereUsed
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Window Name Navigation Path

Mass Change Bills, page 2-48 ECOs > Mass Changes

Operation Resources (See BOM) Prototypes > Routings > Routings > [Operation
Resources]

Reasons, page 1-11 Setup > Reasons

Reference Designators, page 2-43 ECOs > ECOs > [Revised Items] > 
[Components] > [Designators]

Reference Designators (See BOM) Prototypes > Bills > Bills > [Designators]

Resources (See BOM) Prototypes > Routings > Resources

Resource WhereUsed (See BOM) Prototypes > Routings > Resource WhereUsed

Revised Components, page 2-39 ECOs > ECOs > [Revised Items] > 
[Components]

Revised Items, page 2-29 ECOs > ECOs > [Revised Items]

Routing Details (See BOM) Prototypes > Routings > Routings > [Routing 
Details]

Routing Documents (See BOM) Prototypes > Routings > Documents

Routing Revisions (See BOM) Prototypes > Routings > Routings > [Routing 
Revisions]

Routings (See BOM) Prototypes > Routings > Routings

Standard Operations (See BOM) Prototypes > Routings > Standard Operations

Start AutoImplement Manager, page 1-14 Setup >AutoImplement

Substitute Components, page 2-42 ECOs > ECOs > [Revised Items] > 
[Components] > [Substitutes]

Substitute Components (See BOM) Prototypes > Bills > Bills > [Substitutes]

Transfer to Manufacturing, page 3-5 Transfer to Manufacturing
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Window Name Navigation Path

Transfer to Manufacturing from within and 
ECO, page 2-44

ECOs > ECOs >[Transfer]

Oracle Engineering Character Mode Forms and Corresponding GUI 
Windows

The following table matches character mode forms with their corresponding GUI 
windows or processes. This information supplements Windows and Navigator Paths in 
the product online documentation. Text in brackets ([ ]) indicates a button.

The GUI Navigator paths are based on the Engineering responsibility.

The following table presents more information on any window, navigate to the window
and choose the help icon.

Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Assign Key Flexfield Security Rules

\Navigate Setup Flexfields Key Security 
Assign

Assign Security Rules

Navigator: Setup > Flexfields > Key > Security 
> Assign

Assign Security Rules

\Navigate Setup Flexfields Validation 
Security Assign

Assign Security Rules

Navigator: Setup > Flexfields >Validation > 
Security > Assign

Bill of Material Comparison Report

\Navigate Report Bill Compare

Bill Components Comparison

Navigator: Prototypes > Bills > Comparison

Bill of Material Loop Report

\Navigate Report Bill LoopCheck

Engineering Bill Reports

Navigator: Reports > Bills

Bill of Material Structure Reports

\Navigate Report Bill Structure

Engineering Bill Reports

Navigator: Reports > Bills
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Calculate Lead Times

\Navigate Prototype Leadtimes

Calculate Lead Times

Navigator: Prototypes > Routings > Lead 
Times

Change Organization

\Navigate Other ChangeOrg

Organization

Navigator: Other > Organization

Define Change Order Types

\Navigate Setup ECO Types

Change Types

Navigator: Setup > Change Types

Define Cross-Validation Rule

\Navigate Setup Flexfields Key Rules

Cross-Validation Rules

Navigator: Setup > Flexfields > Key > Rules

Define Descriptive Flexfield Segments

\Navigate Setup Flexfields Descriptive 
Segments

Descriptive Flexfield Segments

Navigator: Setup > Flexfields > Descriptive > 
Segments

Define Descriptive Security Rule

\Navigate Setup Flexfields Descriptive 
Security Define

Define Security Rules

Navigator: Setup > Flexfield > Descriptive > 
Security > Define

Define Descriptive Segment Values

\Navigate Setup Flexfields Descriptive Values

Segment Values

Navigator: Setup > Flexfields > Descriptive > 
Values

Define ECO Approval Lists

\Navigate Setup ECO ApprovalLists

Approval Lists

Navigator: Setup > Approval Lists

Define ECO Autonumbering

\Navigate Setup ECO AutoNumbering

ECO Autonumbering

Navigator: Setup > AutoNumbering

Define ECO Departments

\Navigate Setup ECO Department

Define ECO Department

Navigator: Setup > ECO Department
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Define ECO Priorities

\Navigate Setup ECO Priorities

ECO Priorities

Navigator: Setup > Priorities

Define ECO Reasons

\Navigate Setup ECO Reasons

Reasons

Navigator: Setup > Reasons

Define Employees

\Navigate Setup Employee

Enter Person

Navigator: Setup > Employees

Define Engineering Bill of Material

\Navigate Prototype Define Bill

EngineeringBills of Material

Navigator: Prototypes > Bills > Bills
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Define Engineering Change Order

\Navigate ECO Define

Engineering Change Orders

Navigator: ECOs > ECOs

or

Approval History

Navigator: ECOs > ECOs > [Approvals]

or

Approval Dates

Navigator: ECOs > ECOs. From the Tools 
menu choose View Dates

or

ECO Revisions

Navigator: ECOs > ECOs > [ECO Revisions]

or

View Reference Designators

Navigator: ECOs > ECOs > [Revised Items] > 
[Components] > [Designators]

or

View Substitute Components

Navigator: ECOs > ECOs > [Revised Items] > 
[Components] > [Substitutes]

Define Engineering Item

\Navigate Prototype Define Item Item

Engineering Master Item

Navigator: Prototypes > Items > Master Items

or

Engineering Organization Item

Navigator: Prototypes > Items > Organization 
Items

Define Engineering Item Revision

\Navigate Prototype Define Item Revision

Item Revisions

Navigator: Prototypes > Bills > Bills > 
[Revision]
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Define Engineering Routing

\Navigate Prototype Define Routing

Engineering Routings

Navigator: Prototypes > Routings > Routings

or

Routing Details

Navigator: Prototypes > Routings > Routings >
[Routing Details]

Define Item Catalog Groups

\Navigate Prototype Inventory Catalog 
Define

Item Catalog Groups

Navigator: Prototypes > Items > Catalog 
Groups

Define Item Cross-References

\Navigate Prototype Inventory 
Cross-Reference

Assign Cross Reference

Navigator: Prototypes > Items > Cross 
References > [Assign]

Define Item Relationships

\Navigate Prototype Inventory RelatedItems

Item Relationships

Navigator: Prototypes > Items > Related Items 
> [Find]

Define Item Template

\Navigate prototype Inventory Template

Item Template

Navigator: Prototypes > Items > Templates > 
[Find] > Item Templates Summary > [Open]

Define Key Flexfield Security Rule

\Navigate Setup Flexfields Key Security 
Define

Define Security Rules

Navigator: Setup > Flexfields > Key > Security 
> Define

Define Key Flexfield Segments

\Navigate Setup Flexfields Key Segments

Key Flexfield Segments

Navigator: Setup > Flexfields > Key > 
Segments

Define Key Segment Values

\Navigate Setup Flexfields Key Values

Segment Values

Navigator: Setup > Flexfields > Key > Values
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Define Rollup Groups

\Navigate Setup Flexfields Key Groups

Rollup Groups

Navigator: Setup > Flexfields > Key > Groups

Define Security Rule

\Navigate Setup Flexfields Validation 
Security Define

Define Security Rules

Navigator: Setup > Flexfields >Validation > 
Security > Define

Define Segment Values

\Navigate Setup Flexfields Validation Values

Segment Values

Navigator: Setup > Flexfields >Validation > 
Values

Define Shorthand Aliases

\Navigate Setup Flexfields Key Aliases

Shorthand Aliases

Navigator: Setup > Flexfields > Key > Aliases

Define Value Set

\Navigate Setup Flexfields Validation Set

Value Sets

Navigator: Setup > Flexfields > Validation > 
Sets

Delete Item Information

\Navigate Prototype Delete

Engineering Deletion Groups 

Navigator: Delete Item Report

Delete Items Report

\Navigate Report Delete

Delete History Report

Navigator: Reports > Delete Groups

Engineering Change Order Reports

\Navigate Report ECO

Engineering Change Order Reports

Navigator: Reports > ECOs

Engineering Setup Reports

\Navigate Reports Setup

Engineering Setup Reports

Navigator: Reports > Setup

Implement Engineering Change Orders

\Navigate ECO Implement

Engineering Change Orders

Navigator: ECOs > ECOs
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Item Cost Information Report

\Navigate Report ItemCosts

Item Cost Information Report

Use the Cost Management responsibility 
Navigator: Report > Cost > Item

Item Reports

\Navigate Report Item

Engineering Item Reports

Navigator: Reports > Items

Mass Change Bills of Material

\Navigate ECO MassChange

Mass Change Bills

Navigator: ECOs > Mass Changes

Purge Engineering Change Orders

\Navigate ECO Purge

Purge Engineering Change Orders

Navigator: ECOs > Delete

Routing Reports

\Navigate Reports Routing

Engineering Routing Reports

Navigator: Reports > Routings

Run Reports

\ Navigate Report

Submit Request window

Navigator: Reports > Run

Search Items

\Navigate Prototype Inventory Catalog 
Search

Item Search

Navigator: Prototypes > Items > Item Search > 
[Find]

Start AutoImplement Manager

\Navigate Setup AutoImplement

Start AutoImplement Manager

Navigator: Setup >AutoImplement

Transfer Engineering Data to Manufacturing

\Navigate Prototype Transfer

Copy to Manufacturing

Navigator: Prototypes > Copy to 
Manufacturing

or

Transfer to Manufacturing

Navigator: Protoypes > Transfer to 
Manufacturing
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

Update Engineering Item/Org Attributes

\Navigate Prototype Define Item Update

Item Attributes

Navigator: Prototypes > Items > View Item 
Details > [Attributes]

Update Personal Profile Options

\Navigate Other Profile

Personal Profile Values

Navigator: Setup > Profiles

View Bill of Material Comparison

\Navigate Inquiry Bill Compare

Bill Components Comparison

Navigator: Prototypes > Bills > Comparison

View Bill of Material Details

Navigate Inquiry Bill Detail

Bill Details

Navigator: Prototypes > Bills > Bills > [Bill 
Details]

View Concurrent Requests

\ Navigate Other Requests 

Requests window

Navigator: Concurrent > Requests

Choose:

View Output button- to view Request Output

View Log button - to view Request Log

Use the Menu to choose:

Tools > Managers - to view Manager Log

View Engineering Change Order Details

\Navigate Inquiry ECO Details

Engineering Change Orders

Navigator: ECOs > ECOs

View Engineering Change Order Schedule

\Navigate Inquiry ECO Schedule

View ECOs

Navigator: ECOs > Schedules

View Engineering Delete History

\Navigate Inquiry DeleteHistory

Warning: Engineering Deletion Groups

Navigator: Prototypes > Routings > Delete 
Groups

View Indented Bill of Material

\Navigate Inquiry Bill Indented

Indented Bills of Material

Navigator: Prototypes > Bills > Indented Bills
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Character Mode Form and Menu Path GUI Window or Process, and Navigation 
Path

View Item Attributes

\Navigate Inquiry Item Attributes

Item Attributes

Navigator: Prototypes > Items > View Item 
Details > [Attributes]

View Item Revision

Navigate Inquiry Item Revision

Item Revisions

Navigator: Prototypes > Bills > Bills > 
[Revision]

or

Revised Items Navigator: ECOs > ECOs > 
[Revised Items] > [Revisions]

View Item Usage

\Navigate Inquiry WhereUsed Item

Item WhereUsed

Navigator: Prototypes > Bills > Item 
WhereUsed

View Routing Details

\Navigate Inquiry Routing

EngineeringRoutings

Navigator: Prototypes > Routings > Routings
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B
Engineering Alerts

Engineering Alerts
Engineering includes these pre-coded alerts that you can use with or without 
customizing.

ECO Approval Notification
This alert notifies all the approvers on an ECO's approval list that an ECO requires their
approval

Alert Type Periodic

Periodicity Every n business days

Inputs Organization

Distribution Approvers for the ECO

Example:



B-2    Oracle Engineering User's Guide

ECO Use Up Date
This alert notifies the ECO planner that a plan date for a use-up item has changed.

Alert Type Periodic

Periodicity Every n business days

Inputs Organization

Distribution ECO requestor

Example:
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C
Engineering Tools Menu

Engineering Tools menu
Change the status of ECOs and ECO revised items by using the Tools menu and 
choosing a status. Other functions available from the Oracle Engineering Tools menu 
include:

Reschedule Opens the Reschedule window to reschedule 
ECOs and ECO revised items. To reschedule 
ECOs, the Engineering Change Orders: 
Reschedule security function must be 
included as part of the responsibility.

Enter Costs Opens the ECO Costs window so that you can
enter engineering or manufacturing 
implementation costs.

Copy Bill from Opens the Copy Bill window so that you can 
copy a bill into an ECO.

Check for Loops Verifies that a bill does not contain items are 
not listed as components of the same item. 
Opens the Approval Dates window which 
shows the date the ECO approval list was 
requested, the date it was approved, or the 
days remaining for approval to take place.

View Dates View ECO information including: scheduling 
information, pending and implemented ECOs 
approval status, revised item status, etc.
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View Approvals If an approval list is used, the approval status 
can only be changed manually, pending 
formal approval from a list member. If a 
workflow process is associated with the ECO, 
the approval status is changed automatically.

Abort Approvals Aborts the Workflow approval process. This is
only available if the ECO approval status is 
Approval Requested. This is only available if 
the ECO: Approvals security function is 
included as part of the responsibility.

Related Topics
Changing the ECO Status, page 2-27

ECO Statuses, page 2-59

ECO Revised Item Statuses, page 2-59

Rescheduling an ECO or Revised Items, page 2-27

Defining Implementation Costs, page 2-28

Assigning an ECO Approval List and Status, page 2-25

Engineering Profile Options and Security Functions, page 1-15

Copying Bill and Routing Information, Oracle Bills of Material User's Guide

Checking for Bill Loops, Oracle Bills of Material User's Guide
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21 CFR Part 11 Compliance

21 CFR Part 11 Overview
The Food and Drug Administration (FDA) protects the public health by regulating the 
food and drug industries. In 1997, the FDA issued new regulations for quality systems 
using computerized software in the FDA Code of Federal Regulations (CFR) Title 21 
Part 11, otherwise known as 21 CFR Part 11. The regulations strive to assure that 
computerized records are safe, secure, and as accurate as a paper based system. 

According to 21 CFR Part 11, the software application's role in the data management 
process is to guarantee and substantiate that the manufactured product data is 
electronically captured, manipulated, extracted, and coded during the manufacturing of
the product. All subject data and definitional objects (metadata) must have a complete 
audit trail.

In general, 21 CFR Part 11 describes the requirements that must be met when using 
electronic records (e-records) and electronic signatures (e-signatures), but does not 
describe where they are required. The FDA left the definition of where to use electronic 
records and which signatures to apply as electronic signatures to the discretion of the 
medical device manufacturers who use software applications as part of their quality 
management system. The predicate rule used by the medical device manufacturers is 
FDA 21 CFR Part 820. Oracle Engineering enable electronic records and signatures for 
certain business events (as described in this chapter), as well as give users ways to 
choose which business events must meet 21 CFR Part 11 requirements, by using the 
Oracle E-Records product. Refer to the Oracle E-Records Implementation Guide for 
information on how to tailor Oracle E-Records to meet your needs. 

Depending on the type of business event, an electronic signature is either online or 
deferred. An online signature requires that you enter a valid signature before saving the
event or transaction. 

Certain business events also include any attachment made to the business event object 
in the e-record. For example, if a drawing depicting an engineering change is attached 
to an engineering change order, you can review the drawing in the e-record for the 
engineering change order.
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The e-records and e-signatures (ERES) framework is a central tool designed to achieve 
21 CFR Part 11 compliance for the necessary Oracle Applications business events. The 
ERES framework uses common Oracle Applications components such as Oracle 
Workflow business events, the XML Gateway, and others.

In order to enable electronic records and signatures for Oracle Engineering, you must 
follow the steps listed in Implementing E-Records, Oracle E-Records Implementation Guide
. Otherwise, no e-records or e-signatures are required. 

Related Topics
E-Records and E-Signatures for Oracle Engineering, page D-2

See Viewing Oracle E-Records and E-Signatures

E-records and E-signatures for Oracle Engineering
The following table lists the Oracle Engineering events seeded in Oracle E-Records.

Event Online or Deferred 
E-signature

E-Record Includes 
Attachment

ECO Creation Online* Yes

ECO Update Online* Yes

ECO Approval Deferred Yes

ECO Implementation Online* No

ECO Schedule Online* No

ECO Reschedule Online* No

ECO Cancellation Online* No

Transfer to Manufacturing Online No

Copy to Manufacturing Online No

* By default, the online e-signatures marked with an asterisk (*) are disabled. To enable 
e-signatures for these events, change the ESIG_REQUIRED configuration variable 
default value to Y. See: Setting Up the Configuration Variables, Oracle E-Records 
Implementation Guide.
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ECO Creation or Update
The Engineering Change Orders window starts the record capturing process whenever 
an ECO is created or changed.

ECO Approval
When a completed ECO is submitted for approval, the required e-signatures must be 
captured to complete the approval process. You can enter your signature online, while 
the event is happening in the window or in deferred mode. All users in the ECO 
approval list receive workflow notifications requesting that they provide their 
e-signature before the ECO is approved.

The ECO Approval process requires an additional setup step in Oracle Engineering 
because this process is not defined in Oracle Approvals Management. You must 
associate the Change Type and Priority used by the ECO with the ERES Approval 
Process in Oracle Workflow. See: Defining ECO Types. 

When creating the ECO, you must enter a Change Type and Priority that is associated 
with the ERES Approval Process. You must also select a valid approval list in the 
Approval List field.

ECO Implementation
You can create an e-record upon either manual or automatic implementation of an ECO.
When you implement an ECO, a concurrent program executes your command, captures
an e-record, and invokes the necessary event to make the change. The necessary event 
could be a bill, routing, or item update or a transfer or copy to manufacturing. See: 
Implementing ECOs..

ECO Schedule, Reschedule, or Cancellation
The action of scheduling, rescheduling or cancelling an ECO creates an e-record. When 
you select Schedule, Reschedule, or Cancel from the menu, you must enter the date and 
time, then confirm the action. Once you confirm the action, the e-record is created. See: 
Implementing ECOs, , Rescheduling an ECO or Revised Item, Oracle Engineering User's 
Guide, or Cancelling ECOs and Revised Items, Oracle Engineering User's Guide for more 
information.

Transfer or Copy to Manufacturing
When you transfer or copy items, bills, and routings to manufacturing from within the 
Engineering Change Orders window using the ERES Approval Process in Oracle 
Workflow, you eventually schedule an ECO implementation. The e-record is created as 
described for an ECO implementation and the e-signature is collected as described for 
an ECO Approval previously in this section. This is the recommended method for 
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transferring or copying data to manufacturing and Oracle suggests removing the other 
menu entries for manually transferring or copying engineering data to manufacturing. 

If you need the flexibility to manually transfer or copy data to manufacturing, the other 
navigator paths for manually transferring engineering data are provided below. The 
paths for manually copying engineering data are the same; substitute the word Copy in 
place of Transfer.

• Engineering > Prototypes > Transfer to Manufacturing

• Engineering > Prototypes > Items > Master/Organization Items (M) Tools > 
Engineering Transfer

• Engineering > Prototypes > Bills (M) Tools > Transfer Bill

• Engineering > Prototypes > Routings (M) Tools > Transfer Routing

These paths open the Transfer to Manufacturing or the Copy to Manufacturing 
window. These windows create an e-record and require an online e-signature for every 
record line once the event is saved.

Related Topics
Viewing Oracle E-Records and E-Signatures, page D-4

Also see: 21 CFR Part 11 Overview in the Oracle Engineering User's Guide.

Viewing Oracle E-Records and E-Signatures
You can view e-records and e-signatures using the following methods:

• Using the Oracle E-Records Evidence Store to query e-records and e-signatures. See:
Evidence Store, Oracle E-Records Implementation Guide.

• Selecting the eRecord Details option from the Tools menu of a transaction or event 
initiating form. This option is available from many, but not all, of the transaction or 
event initiating forms.

Related Topics
21 CFR Part 11 Overview

E-Records and E-Signatures for Oracle Engineering
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